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SPECIFICATIONS SUBJECT TO CHANGE WITHOUT NOTICE

Notice

While reasonable efforts have been made to assure the accuracy of this document, Telit
assumes no liability resulting from any inaccuracies or omissions in this document, or from
use of the information obtained herein. The information in this document has been carefully
checked and is believed to be entirely reliable. However, no responsibility is assumed for
inaccuracies or omissions. Telit reserves the right to make changes to any products described
herein and reserves the right to revise this document and to make changes from time to time
in content hereof with no obligation to notify any person of revisions or changes. Telit does
not assume any liability arising out of the application or use of any product, software, or
circuit described herein; neither does it convey license under its patent rights or the rights of
others.

It is possible that this publication may contain references to, or information about Telit
products (machines and programs), programming, or services that are not announced in your
country. Such references or information must not be construed to mean that Telit intends to
announce such Telit products, programming, or services in your country.

Copyrights

This instruction manual and the Telit products described in this instruction manual may be,
include or describe copyrighted Telit material, such as computer programs stored in
semiconductor memories or other media. Laws in the Italy and other countries preserve for
Telit and its licensors certain exclusive rights for copyrighted material, including the
exclusive right to copy, reproduce in any form, distribute and make derivative works of the
copyrighted material. Accordingly, any copyrighted material of Telit and its licensors
contained herein or in the Telit products described in this instruction manual may not be
copied, reproduced, distributed, merged or modified in any manner without the express
written permission of Telit. Furthermore, the purchase of Telit products shall not be deemed
to grant either directly or by implication, estoppels, or otherwise, any license under the
copyrights, patents or patent applications of Telit, as arises by operation of law in the sale of a
product.

Computer Software Copyrights

The Telit and 3rd Party supplied Software (SW) products described in this instruction manual
may include copyrighted Telit and other 3rd Party supplied computer programs stored in
semiconductor memories or other media. Laws in the Italy and other countries preserve for
Telit and other 3rd Party supplied SW certain exclusive rights for copyrighted computer
programs, including the exclusive right to copy or reproduce in any form the copyrighted
computer program. Accordingly, any copyrighted Telit or other 3rd Party supplied SW
computer programs contained in the Telit products described in this instruction manual may
not be copied (reverse engineered) or reproduced in any manner without the express written
permission of Telit or the 3rd Party SW supplier. Furthermore, the purchase of Telit products
shall not be deemed to grant either directly or by implication, estoppels, or otherwise, any
license under the copyrights, patents or patent applications of Telit or other 3rd Party supplied
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SW, except for the normal non-exclusive, royalty free license to use that arises by operation
of law in the sale of a product.
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Usage and Disclosure Restrictions
License Agreements

The software described in this document is the property of Telit and its licensors. It is
furnished by express license agreement only and may be used only in accordance with the
terms of such an agreement.

Copyrighted Materials

Software and documentation are copyrighted materials. Making unauthorized copies is
prohibited by law. No part of the software or documentation may be reproduced, transmitted,
transcribed, stored in a retrieval system, or translated into any language or computer language,
in any form or by any means, without prior written permission of Telit.

High Risk Materials

Components, units, or third-party products used in the product described herein are NOT
fault-tolerant and are NOT designed, manufactured, or intended for use as on-line control
equipment in the following hazardous environments requiring fail-safe controls: the operation
of Nuclear Facilities, Aircraft Navigation or Aircraft Communication Systems, Air Traffic
Control, Life Support, or Weapons Systems (High Risk Activities"). Telit and its supplier(s)
specifically disclaim any expressed or implied warranty of fitness for such High Risk
Activities.

Trademarks

TELIT and the Stylized T Logo are registered in Trademark Office. All other product or service names
are the property of their respective owners.

Third Party Rights

The software may include Third Party Right software. In this case you agree to comply with all terms
and conditions imposed on you in respect of such separate software. In addition to Third Party Terms,
the disclaimer of warranty and limitation of liability provisions in this License shall apply to the Third
Party Right software.

TELIT HEREBY DISCLAIMS ANY AND ALL WARRANTIES EXPRESS OR IMPLIED FROM
ANY THIRD PARTIES REGARDING ANY SEPARATE FILES, ANY THIRD PARTY MATERIALS
INCLUDED IN THE SOFTWARE, ANY THIRD PARTY MATERIALS FROM WHICH THE
SOFTWARE IS DERIVED (COLLECTIVELY “OTHER CODE”), AND THE USE OF ANY OR ALL
THE OTHER CODE IN CONNECTION WITH THE SOFTWARE, INCLUDING (WITHOUT
LIMITATION) ANY WARRANTIES OF SATISFACTORY QUALITY OR FITNESS FOR A
PARTICULAR PURPOSE.

NO THIRD PARTY LICENSORS OF OTHER CODE SHALL HAVE ANY LIABILITY FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND
WHETHER MADE UNDER CONTRACT, TORT OR OTHER LEGAL THEORY, ARISING IN ANY
WAY OUT OF THE USE OR DISTRIBUTION OF THE OTHER CODE OR THE EXERCISE OF
ANY RIGHTS GRANTED UNDER EITHER OR BOTH THIS LICENSE AND THE LEGAL TERMS
APPLICABLE TO ANY SEPARATE FILES, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Copyright © Telit Communications S.p.A. 2015.
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1. Introduction

1.1. Scope

The scope of this document is to provide information on how to use the TelitView tool.

More specifically, this document introduces the features contained in the TelitView and how
to use them to evaluate and get familiarized with the features and performances of Telit’s
GNSS modules.

This User Guide is intended for users interested in understanding Telit’s GNSS receiver
modules, and who want to manage and control the GPS/GLONASS activities, and conduct
tests on the Telit’s GNSS module.

1.2. Contact Information, Support

For general contact, technical support, to report documentation errors and to order manuals,
contact Telit Technical Support Center (TTSC) at:

TS-EMEA@telit.com
TS-AMERICAS@telit.com
TS-APAC@telit.com

Alternatively, use:
http://www.telit.com/en/products/technical-support-center/contact.php

For detailed information about where you can buy the Telit modules or for recommendations
on accessories and components visit:

http://www.telit.com

To register for product news and announcements or for product questions contact Telit
Technical Support Center (TTSC).

Our aim is to make this guide as helpful as possible. Keep us informed of your comments and
suggestions for improvements.

Telit appreciates feedback from the users of our information.

N
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1.3. Text Conventions
@ Danger — This information MUST be followed or catastrophic equipment failure or bodily
injury may occur.

C Caution or Warning — Alerts the user to important points about integrating the module, if
these points are not followed, the module and end user equipment may fail or malfunction.

Tip or Information — Provides advice and suggestions that may be useful when integrating
the module.

All dates are in ISO 8601 format, i.e. YYYY-MM-DD.

1.4. Related Documents

Please refer to the Applicability Table for the supported Telit GNSS modules.

s =l
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2. Installation of TelitView
For each type of receiver, please refer to the Applicability Table for the supported Telit GNSS
modules in order to install the applicable USB drivers and connect the receiver to the PC.

2.1. Downloading

Go to the Telit Download Zone http://www.telit.com/download-zone/ .
After Log In: Click on Software > GNSS > Software tools
Download the latest file:TelitViewlnstall.x.x.x

2.2. System Requirements

Microsoft .NET Framework 4.0 or later.

If a user wants to determine which version of .NET Framework is installed in his computer,
he can follow these procedures:

1. On the Start menu, in the search box, type: regedit
You must have administrative credentials to run regedit.exe.

2. In the Registry Editor, open the following sub key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP

The installed versions are listed under the NDP sub key. The version number is stored in
the Version entry. For the .NET Framework 4, the Version entry is under the Client or Full
sub key (under NDP), or under both sub keys.

N
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2.3. Installation

TelitView is a Windows application.
In order to install TelitView on your computer:
Run the file TelitViewlnstall_x_x_x.msi (x_X_X is the version id) and follow the TelitView

Setup Wizard:
rﬁl TelitView = _——
Welcome to the TelitView Setup Wizard LA

The inztaller will guide wou through the steps reguired to install Telitiew on wour computer,

WARMING: This computer program iz protected by copyright law and international treaties.
Unautharized duplication or distribution of this program, or any portion of it, may rezult in severe civil
or criminal penalties, and will be prozecuted ta the maximum extent pozsible under the law.

Figure 2 TelitView Setup Wizard

> Next
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4 TelitView I = S|

Select Installation Folder |_‘| \_

The inztaller will inztall Telitfiew ta the following folder.

To install in this folder, click "Mext". Toinstall to a different folder, enter it below or click "Browse". |

| !
Folder:

|E: “Program Files [«86]1WTELITAT elifiew’, Browsze...

[ Cancel ] [ < Back ] [ Mesut >

Figure 3 Select Installation Folder

> Next
rﬁl TelitView I = S |

Confirm Installation |_‘I \_

The inztaller iz ready to ingtall Telitview on pour computer,

Click "Mext" ta start the installation.

[ Cancel ] ’ < Back ] [ Mest >

o

Figure 4 Confirm Installation

- All Rights
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4 TelitView I ‘

Installation Complete

Telitview haz been successfully installed.

Click "Close" to exit.

Cancel < Back

Cloze

b -

Figure 5 Installation Complete
> Close.

Like a typical Windows desktop application, the installer h

as just installed the TelitView

application into the computer and it can be launched from the “Start” menu.

Normally the program is installed under the “\TELIT\TelitView_x_x_x” folder (x_x_x is the
version id) and the executable name is “TelitView_x_x_x”.

Find the application and double click on it to launch the program in the default placement.

: | =
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Setup of TelitView

Program Start and the Main Interface

After TelitView has been installed, launch the program by double-clicking the desktop icon
(if there is one added during the installation process or by the user), or from the PC’s “Start”
menu, clicking All Programs -> TelitView_X_x_X (X_X_x is the version id).

Once the user launches the program for the first time after the installation, it appears on the
screen like this:

T Telitview — - o (50
A — —
Setup Views Tools Commands Test Windows Help
SelenmBE =0 xdmEl 85 5@
I T NMEA Moritor [ '@ [z | | T Scatterpiot = JF= @S | T Navigation States [ ® [=] I
Navigation Update Info Global
we ] w5 D
s : e e —
— ook: [0 e [0
el Geaibpm L I
SV Tracked: [ ac [ 0] Honortal B Geoidal Sep [m]
Raw Dat; dCR
Rl el I e e R —
T RX Longitude [']
Y e s
o T e —
A o st [ | [
= O
il
BDS Iview /Used [ ][]
o St [ |
o] se | 5] v ]
TTFFIsl [ n/a| | Pos Type | |
T Signal Quality Chart === | T Admuth Elevation =E=

Display Threshold 55 ‘

Signal Quality [dBHz]

[Session ID: 0] State: No Connection

Figure 6 The Main user interface at the default window layout
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The following figure illustrates TelitView’s menu bar and tool bar:

- — — B
T TelitView — - o 5 e S
Setup  Views Tools Commands Test  Windows Help
= & N m | EMuw ¥FEWL|EEE @
[Session ID: 0] State: Mo Connection IJ

Figure 7 Menu bar and the Tool bar

3.2. Connecting TelitView with a GPS Receiver through a
COM port

To connect TelitView with a GPS receiver through an available COM port on PC, follow
these steps:

»  From the main menu, click Setup > Comm Port

«  Or from the tool bar: Click the Comm Port icon ==

The “Connect to Receiver” dialog box will pop up.

T Connectto Receiver @

Communication Port

[com1o -
Baud Rate

| 9600 -]
Telt Module

NON-SPECIFIC

| Cancel | | ok |

Figure 8 Connect to Receiver dialog box

If TelitView runs for the first time on a PC machine and it has not communicated with a Telit
GNSS module, “Telit Module” field will display “NON-SPECIFIC”, otherwise a module type

from the last time TelitView run will be displayed.
:
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Make Connection

From the dropdown list:
» Select the correct COM port connected to a GPS receiver.
»  Select the correct baud rate.
» Select the type of Telit module connected (optional, see below).
« Click“OK”.

If the port is selected and the baud rate is set correctly, TelitView program will show the
serial data activities on the screen, as well as the data plots in its open windows.

The status bar will show the current communication state: “Connected [COMxx, Baud xxxx],
as indicated by the following figure.

SGPGGA,000603.000, 3340 257
SGPG3AAZTT.04.28,24 2615
SGPRMC,000603.000,A,3340.3

4 | 1

4 | 11

[Seszion ID: 0] State: Connected [COMZE, Baud 4800]

Figure 9 COM port communication state (with the current Session ID)

About Telit Module Type

This selection is optional if the user is connecting the COM port to a receiver and only wants
to see receiver’s data output activities as they are displayed on the view windows. A module
type of any selection is not a requisite on the purpose of monitoring the data on views.

The default type of “NON-SPECIFIC” indicates that no particular module type has been
selected.

e When must a module type be selected?

After setting up connect, if the user plans to send commands to the module, he has to have the
Telit module type specified correctly, because all commands are module specific. In those
cases, the module must be a specific type that corresponds to the module connected, other
than “NON-SPECIFIC” type. User can make the selection either from this dialog box or
from the menu selection for the product type, as described in Section 4.1 Setup Menu.
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Other situations when a module type needs to be selected include when the user wants to view
data associated with the type of satellite constellations. For example, if the user wants to see
TelitView display GLONASS, BeiDou information in the signal view windows, a correct
type of module needs to be specified for the target, as the output for those data is generated
differently by different chipsets.

Status Bar

Located at the bottom left corner is the status bar. The status bar shows the current
connection status of the COM port, such as the

« Connection state: connected, disconnected, or no connection

» COM port parameter: port name and baud rate (when the port is connected

The status also shows additional information as related to the connection, such as a Session
ID. Please refer to Section 7.7.2 Sessions & Connection Profiles for more details about the
Session.
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4, Introduction to Menus and Toolbar

This section provides a brief description to TelitView menus and tool bar icons.

4.1. Setup Menu

Setup [|Views  Tools

Comm Port

Replay

=
I:' Disconnect
ﬁ

Start Log
Stop Log

Products

Sessions

Convert

Exit

Figure 10 Setup Menu

The Setup Menu includes the following entries and their functions accordingly:

e Comm Port

Launches the “Connect to Receiver” dialog box to configure the COM port parameters and to
the receiver connected to the COM port as the data source.

e Replay

Launches a File-open dialog box and allows the user to select and replay a pre-recorded data
file (in a standard NMEA data format) as the data source.

e Disconnect

Disconnects the data source which is either the serial port or the replay of the log file.
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e Start Log

Launches a File-open dialog box and allows the user to specify a file name to save the data.
Then opens the file and starts to log the data.

e Stop Log

Closes the log file if one is open.

e Products

Selects the particular product type for the receiver module connected to the COM port.
e Sessions

Creates, runs, and manages sessions.

e Convert

Conducts data conversion from a source file to various format in a destination file that can be
used as input file for different kinds of post-processing tools.

e Exit

Exits the program.
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4.2. Views Menu

S|

T TelitView — D

Setup || Views ||Teels Cemmands

= & Mavigation States
MMEA Monitor
Signal Quality
Azimuth Elevation

Scatter Plot
Data Cverview

Data Charts

|!" Custom Messages

Figure 11 Views Menu

The Views Menu entries are the launching commands for the following windows:

¢ Navigation States

The display of the navigation data in a form of list on the second-epoch update basis.

¢ NMEA Monitor

The primary “Console” to control (sending command messages) and monitor the messages
constantly received by TelitView.

e Signal Quality

The display of the signal strength of satellites (GPS / GNSS) as they are received by the
receiver, in doHz.

e Azimuth Elevation

The display of the satellite in view in terms of their azimuth and elevation, and their usage
status at the epoch.

L S
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e Scatter Plot

The display of the position / navigation tracks in the 2D adjacent plot, as well as the
navigation status updates on the error estimate.

e Data Overview

The display of navigation data in a tabular form with rows and columns, providing extended
overview of the status and calculations on the second-epoch basis.

e Data Charts

The display of time-sequence of navigation data, in the parameters such as SVs in use,
HDOP, Latitude, Longitude, Altitude (HAE), etc.

e Custom Messages

Custom configurable message window that allows user to adjust settings to display the
received messages to be monitored.

#_(Ee
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Tools Menu
-
T TelitView N
Setup  Views| | Tools | |Commands Test Windows Help
= = "‘| »  Replay Data L | [»  Slow
T NMEA Monit Pause > Nomal |
B Stop »  Fast
User Commands Manager 3 I
SRR DR Centrol Panel | M S
SPMTKI0Z"31 MO-DR Control Panel
[ Raw Data EPO Host Manager
™= Auto-baud to MMEA protocol

Figure 12 Tools menu

The Tools menu entries are the built-in tools in TelitView.

The current implemented features include controls that are used when TelitView is being used
like a data player, or “replay” mode.

The features also contain entries that link to various tools that allow users to run different
kinds of specific control and monitor tasks, as well as user specific command management
provision.

o Replay Data

This is a set of control commands that enables the replaying of a log file at different speeds.

While the speed control on replay is implemented under this Tools menu, opening a log file
and closing it are implemented under Setup menu.

e Pause

This control has dual operations — to “pause” or to “resume”. It is enabled during both types
of data source — COM port serial data or the replay of a log file.

e Stop

This control stops a Replay.
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e User Commands Manager

The provision allows the user to load a User Commands File that is product specific XML
file, and manage the User Commands contained in the file.

User may access this menu for the following operations:

o Add new user command, using the “New/Modify” submenu

o Load the user commands, using the “Load User Commands to Menu” submenu
Please refer to Section 7.4 Create and Maintain Commands Files for more detailed
information.

e DR Control Panel

This menu brings up the Dead Reckoning (DR) control panel used as DR control and display
console. Itis used for DR specific testing and monitoring.

¢ MO-DR Control Panel

A positioning system of MEMS-DR is referring to a GNSS + DR system that uses the Micro-
Electro-Mechanical Systems (MEMS) sensors to provide signals such as accelerometers,
magnetometers, gyroscopes, and barometers.

This menu brings up the MEMS only DR control panel used as DR control and display
console. It is used for MEMS specific testing and monitoring.

e EPO Host Manager

The EPO stands for Extended Prediction Orbit — a type of server-generated extended
ephemeris developed and supported by Mediatek®. This feature is added to support Telit
GNSS modules whose features are Mediatek® chipset specific.

This menu brings up the EPO Host Manager. This is a product specific tool used to manage
the EPO feature provided in SL869-V2 (or other Telit GNSS modules that use devices from
Mediatek Inc®).

e Auto-baud to NMEA Protocol

This menu launches TelitView’s auto-baud rate detection feature in an attempt to detect the
baud rate that the GNSS module currently runs to the PC COM port.
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Commands Menu

T TelitView
Setup  View Tools ||Commands || Test Windo
= £ ;| ] Basic Commands
T NMEA Monitor Uzer Commands

Figure 13 “Commands” menu

The Commands menu entries contain two types of the command sets:

e Basic Commands

These commands are provided as the built-in commands by TelitView, from the relevant
XML file installed during the installation process.

e User Commands

These commands are created and maintained by the user, and by nature are custom created
and customer specific to meet testing and control purposes for the customer.

Please refer to Section 7.4 Create and Maintain Commands Files for more details.

Test Menu
Command Test | indows  Help
e | EE i Set Reference Position

Looplt! Test

Special Settings
Figure 14 "Test" menu

The Test menu entries contain the following commands specific to functions of running tests.

e Set Reference Position

Launches a dialog box that allows the user to configure TelitView to use a position as a
reference. The position is specified in the form of Latitude, Longitude, and Altitude values.

Please refer to Section 7.5 Configure Reference Position for more details.
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o Looplt! Test

TelitView provides this utility for users who wish to run a repeated TTFF test, with a test
suite with configurable parameters to meet different testing needs.

e Special Settings

This menu leads to a dialog box that allows user to set up various testing flags or TelitView
system conditions that are special or changes the default behavior of TelitView.

4.6. Windows Menu

Test | Windows | Help
M u Cascade

Tile Horizontal

Tile Vertical

Restore Default Placerment

Figure 15 "Windows" menu

This Windows menu contains the commands for TelitView’s windows placement
management.

e Cascade
e Tile Horizontal
e Tile Vertical

e Restore Default Placement

These commands and their actions are self-explanatory.

After installing the program and running it for the first time, placement of the windows in
TelitView is persistent — TelitView will start with the placement from the last time the user
exits the program.

The last command in this menu, “Restore Default Placement”, is provided for the user to
restore the default placement.

i
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4.7. Help Menu

Test  Windows || Help
M o * He E About TelitView

= | User's Manual |

Figure 16 "Help" menu

The Help menu includes the following:

e About TelitView
o User's Manual
These commands and their actions are self-explanatory.

4.8. Toolbar/lcons and Their Functionalities

Like a typical Windows application, TelitView provides the user a toolbar for quick access to
features that correspond to the menu entries listed above.

el en m ||

State: No Connection

Figure 17 Toolbar on TelitView
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List of the icons on the toolbar and their functions

Icon Name Functionality

I:I Comm Port Launches a dialog box to configure a COM port, and
= open it (to connect it to the receiver).

@ Replay Launches an Open File dialog box and opens a log file,

and replays it.

>< Disconnect Disconnects the current open data source, either the
e open COM port or open replay file.

Q Rewind Rewinds the replay file (to the beginning).

This feature is enabled only in the data replay mode.

Pause/Resume | Pauses / Resumes the display.

This feature is enabled in either COM port or data
replay mode.

N > Replay stop | Both icons share the same toolbar button.

and Play ) o
Replay stop is enabled when the program is in the data
replay mode. When pressed, it is to stop the replay.
Play is enabled when user pressed “Rewind” to direct
the replay back to the beginning of the replay file, he
may press this Play button to start to replay.
E Start log Launches an Open File dialog box, and starts to log the
data into a disk file.
E Stop log Stops (closes) the log file that is open to save the data.
—— Navigation Launches the “Navigation Status” window.
—— status
NMEA Launches the “MNEA Monitor” window.
Monitor

-

P T %
% |Lr: z
- > :
PR
Hilyd
— .
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| | | Signal Quality | Launches the “Signal Quality” window.

E Azimuth Launches the “Azimuth Elevation” window.
Elevation

Safe, Scatter Plot Launches the “Scatter Plot” window.

— Data Launches the “Data Overview” window.
= Overview
I-L Data Chart Launches the “Data Chart” window.
H Hot Reset Command to send a “Hot Reset” message to receiver
) through the COM port.

The actual message content is product-specific.

W Warm Reset | Command to send a “Warm Reset” message to
o receiver through the COM port.

The actual message content is product-specific.

C Cold Reset Command to send a “Cold Reset” message to receiver
i through the COM port.

The actual message content is product-specific.

Figure 18 Toolbar icons and their functions

e rizs
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5. Introduction to Views Windows

This section provides a brief introduction to each window of TelitView under the “Views”
menu, descriptions on the operations / utilities available to users, as well as how to use them.

5.1. Context Menus

As a common control feature, many windows have the context menu available to users.
Typically, the context menus contain the combination of the following commands or features:

e “Clear”:

Clears the data or plot that pertains to the data in the view. Where it is applicable, variables
such as the data count will be reset.

° “Copy”:

Copies the content selected by the user to the clipboard.

In some situations, the user needs to use the Windows-style copy-paste technique for the
extended selection.

For instance, while on one of the plots, right-clicking on the mouse key will bring out a
“Clear” command. User can elect to clear the plot and restart plot over again.
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Navigation States Window

This is the display of the navigation data in a list with useful information pertaining to the
current epoch.

The displayed satellite measurement information includes the position information, DOPs,
GNSS satellites (GPS, GLONASS, Galileo, BeiDou, etc.) that are in-view and are used for
the fix, course information, etc.

It also contains test stats such as the fix status and TTFF information, if applicable.

T MNavigation States o @ [
; \lopal |
Date/Time (UTC) | 01/27/201g] | 21:35:10)
g‘eéﬂ“;ﬂ&['y[m] [ 230300 | 34100)
Latitude [7] 3367088 117.65382 GNSS satellite
Longitude [] | A | information
DOPs P/HAV | 17 | 0§ | 03|
GPS InView / Used | 1| 9 |a
GLO InView / Used | g | 0]
GAL InView / Used | 0 | 0]
BDS InView / Used | 0 | 0]
Course / Speed [Knots] | 2725 | 02|

wode 30| Stetus| ] st rix Il
TTFF [l [ 22605 Pos Type [ GP/5PS

Figure 19 Navigation States view
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5.2.1. Time-To-First-Fix on GNSS

The following figure illustrates the navigation states values, along with a TTFF = 2.2 second.
The Time to First Fix (TTFF) is on GNSS (vs Dead Reckoning, for instance).

T Navigation States o @ [

Date/Time (UTC) |  01/27/201§] | 21:35:10)
e L e
Latitude [*

e [ 33emeg [ 1176532
DOPs P/H/V [ 12 [ o9 [ o9
GPS InView / Used | 1] | 9]
GLO InView / Used | 8 | 0
GAL InView / Used | 0 | 0]
BDS InView / Used | 0 | 0]

Course / Speed [Knots] | 2725 | 0.2]

Mode[ 30| staus__Vad| 5ot [l Fix [
[ Tree e [ 296055 pos Type [ GPSP

Figure 20 Navigation States window and TTFF display
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5.2.2. Time-To-First-Fix on Dead Reckoning (DR)

The following figure illustrates the navigation states values, along with a TTFF = 4.9 second.
The Time to First Fix is on Dead Reckoning (vs GNSS broadcasting signals, for instance).

T Mavigation States EI = @
m
Date/Time (UTC) |  01/03/2008] | 2358:47]
g‘mf"gaﬁ][m] | 20220 | 18.000)
Latitude [*
Lm::ﬂ ud!, ][.] [ 3367108) [ 11765391
DOPs P/H/V [ 12 [ o7 [ o
GPS InView / Used | 1 | 0]
GLO InView / Used | 7 | 0]
GAL InView / Used | 0 | 0]
BDS InView / Used | 0 | 0]
| 1258 | 0.0]

Course / Speed [Knots]

Mode| 30| Staus Vad 5[] i Il
[TTFF 1] 29pR | }»mr,,,e

Figure 21 Navigation States window and TTFF with DR
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5.3. NMEA Monitor

> Menu: Views > NMEA Monitor

T NMEA Monitor [Medule: SL871/5L869-V2] ||
“Send” the
> command
string.
> RX
$SPMTKDB2,0000,0000,0000,0000,0000,0000,0000,0700,0002.60.0272.27,027 ~
SGPTXT.01,01, 02 ANTSTATUS=0K"3B
SGNGGA,220355.000,3340.2427,N,11730.2300,W,2,12.0.95,243.3,M,34.1,M,0 :
SGPGSAA3,18.21,1522,19,24,14.27,,.,1.20,0.950.87*0B Received
SGLGSAA3:87.717286.....129.0.95 08715 -
SGPGSV.3,1,11.22,65,337.36,14,64,194,26,18,48,050,31,48.47, 06 78— | message/
SGPGSV.3,2,11.27.46,265,25.21,45,120,31,19,34,302,21,24.21,069,24*7B message activity
SGPGSV,3,3,11,04,00311,15,06.043,15,32,03,263, 15747

$GLGSV,3,1,09,86,64,203,33.71,48.015,22,72,47,287,17,87,44,318 28"6F
$GLGSV,3,2,09,85,17,167,,73,13.097..80,10,049,,70,08.051,*61
$GLGSV.3.3.09,65,06,251,*5F

$GNRMC,220355.000,A,3340.2427 N,11739.2350,W.0.00,194.88,241114, .06
$GNVTG,194.88.7,,M,0.00.N,0.00.K.D*2A

SPMTKEPH,16,14,15,16,18,19,21,22,24 26,27,29,71,72,85,86,87*73
$PMTKALM,55,1.2,3.4,5,6.7.9.10,11,12,13,14,15,16.17,18,19.20,21,22,23,24 25
$PMTKDBG,10296112,1,1,1,1.0,0.0.1.1.0,0,0,0.0.0.0.0.0.1,1,1,1.1,0.1.0.0.0.0.0.L__
$PMTKDB2,0000,0000,0000,0000,0000,0000,0000,0700,0002.77,0271.32,027_|
$GPTXT,01,01,02 ANTSTATUS=0K*3B .

Figure 22 NMEA monitor view

Title bar —

T MNMEA Monitor [Module: SLE71/5L869-V2] ]

Pause button {:
“Command /’l
string” box
“String to
send” box
$PMTKDE2,00,

$GPTXT.01,01)
$GNGGA 2203

Figure 23 NMEA monitor controls and fields
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Controls on the Window

The NMEA Monitor contains a collection of text boxes and two panes.

e Thetitle bar:

When the user specifies a product type (i.e. SL869, JN3, etc.), the type name will appear on
this title bar, and the color scheme of the panel frame will change as an indicator that a
product type has been selected by the user for the current connection.

e The “Command string” box:

This is the text box where the user types in the command string to send to the receiver. The
text string that appears on this box contains the command string, and any parameters
considered a part of the command string. Other characters such as hex representation of the
checksum, will not be displayed in this box.

Besides manual typing of the user, the data into this box can come from other methods
(described in the sections that follow) before a particular message is to be sent.

e The “Pause” button:

User can click to toggle between pause and resume of update in the views of this window.
Note: Anytime the “Pause” button on the main form toolbar is clicked to “resume” from
“pause”, the “pause” of this button is released as well.

o The “String to send” box:

When a command string is displayed in the “Command string” box, TelitView will attempt to
calculate appropriate checksum and append it to the string in real-time. The command string,
along with the calculated checksum, will be displayed in this “String to send” box.

By design, the default command string is a NMEA sentence-like messages, the message
format contains checksum at the end and separate from the message body by “*”. So normal
use will see the “$”, “*”, and a 2-bytes the checksum value.

TelitView automatically adds a checksum to the command being sent.

e The “RX” pane:

This large “List Box’ style pane is the “receiving” monitor that displays the NMEA messages
(both standard and proprietary) as TelitView receives them, either from the COM port serial
data, or from a replay of a log file.

To provide the user with a good visibility to the data traffic and context information, every
command string sent from this panel is also displayed in the RX pane.
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e The “TX” pane:

This pane is provided to display the command string the user sends when the “Send” button is
clicked, as well as the acknowledgement message TelitView received after a command string
is sent.

Note: The acknowledgement message in the “TX” pane provides feedback to the user as
command strings are sent and allows the user to monitor the activity of the command send /
receive sent.

TelitView does not attempt to filter, parse, and display the acknowledgement messages based
on the interface specification.

In some cases, a receiver may send out multiple and variant length messages as a result from a
command string; in that case TelitView will post a message to indicate the activity.

¢ The checkbox “Raw Data”:

When this is checked, TelitView will stop trying to add a checksum to the command string to
be sent. Instead, it will send the command string in the “Command” box across to the
receiver without any appendance or change.

With this provision checked, text string will be sent in its original form when “Send” button is
clicked.

e The checkbox “Append CR”:

When this checkbox is checked, TelitView will add a Cartridge Return (character ‘\n”) to the
end of the string shown in the “Command” box. This appendance occurs regardless if the
command string has a CR character or not if this checkbox is checked.

Particular Features

o Different Ways to Create a Command String

In addition to manual type by the user to create a command string in the “Message” box, the
box will take string from other ways as the input.

After any one of the following scenarios, the user simply clicks the “Down” arrow and selects
a string, and click “Send”.

o From “History” list:

All strings sent from this monitor (by clicking “Send”) are automatically saved by the
program. In other words, the strings that are sent have been saved as a “history”. When
TelitView is launched, this history is automatically loaded and made available to the
“Message” box — it is a Dropdown box that lists the strings that have been sent before.
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¢ From the “Basic Commands” or “User Commands”’;

When the user selects one of the commands either from the “Basic Commands” or “User
Commands” (by clicking the command), the action will place the command string in the
“Message” box.

e Copy-Paste from the Clipboard:

The user can elect to copy a string from any source — to the clipboard — then paste it onto the
“Message” box.

e Grab Message for Custom Messages Window

As described from the Custom Messages Window, if the user would like to have received
messages displayed in the Custom Messages window, the user needs to enter the message
header as a filter to the Custom Message setting.

One of the ways to supply such a message is to “grab” it from the NMEA Monitor’s “RX”
pane.

While the Custom Message window is open, the user may click the "Pause"” button to pause
the display, and locate a particular message to add it as a target message header, and then
double-click on the message string. TelitView will grab the message and trim it to make a
message header, and place it onto the “Message setting” box.

Signal Quality

This window below displays the tracking states and signal quality of the satellites in CNo
(dBHz.)

» Their SVIDs and signal levels in the Signal Quality Chart view

« The GNSS source, SVIDs, satellite states and other real time parameters
» The elevation and azimuth information in the Azimuth Elevation view

*  GLONASS satellites are shown in the circle.
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[ T Signal Quality Chart

Src Sld Ele

GF 1 4
GF 3 15
GF 10 3
GF 11 4
GF 14 42
GF 18 2

GP 22 72
GF 23 2

GF 31 62

GL B 42
GL BE 41

GL 74 8

GL 75 44
GL &2 14
GL &8 20

=0 ESH =
Avg.CNo[33.7] Display Threshfid 55
Azi Sta CMo |—
3061 42 -
031 26 o
99 0 17 g
2751 44 =
42 1 4 £
110 0 3
20 1 47 b=
2460 0 g
1351 44 2
49 1 36
3261 43
25 1 20 1 3 10 11 14 18 22 2
66 1 33
3261 28
2161 33
Bersu [ cou P seasu
Signal quality view: GPS signal and satellite states

Figure 24:

With GNSS receiver that supports GNSS (GPS, GLONASS, Galileo, BeiDou, etc.); the
Signal Quality view will display the satellite constellation and the states information
accordingly.

Refer to the Section 9.1 Display Examples of GNSS Signal for more examples.

Signal Level Bar Chart

The right side of figure above illustrates the following information:

SVIDs that are tracked and used. SVIDs are shown along the X-axis, and for GPS
constellation signals, the Space Vehicle ID (SVID) range is 1 through 32.

e Signal quality. The signal level for each satellite is shown as the attitude of each bar,
along with its CNo value (dBHz).

o Satellite Usage Flag. “GPS Used” marker will be present if there is at least one
satellite has the state of “1” — the satellite is being used for a position fix.

Satellite Tracking States

The left side of above figure illustrates the following information:

e Source name (“Src”). This name can be the combination of the following:

o

o

“GP” - GPS,

“GL” — GLONASS,
“GA” — GALILEO,
“BD” — BEIDOU,
“SB” — SBAS
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o “QZ”-QZSS

e  Other information for the following:
o Satellite ID (“Sld’) — SVID, the same as in the Signal Level Bar Chart
o Elevation (“Ele”) — the elevation of each satellite
o Azimuth (“Azi”) — the azimuth of each satellite

o State (“Sta”) — the state of the satellite: “1” indicate the satellite is used in
solution.

o CNo - Signal CNo numbers; it is the same as the bar height in the Signal Level
Bar Chart on the right side.

5.4.3. Additional Information Control and Display

e Average CNo:

This box displays the average CNo value from all satellites that are in view on the current
update.

o Display Threshold:

This is a user selectable control to adjust how he would like the satellite information to be
displayed by selecting the minimum value for the signal CNo.
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5.5. Azimuth Elevation

This window displays the satellites by Azimuth and Elevation.
The figure below illustrates the following information:
» Satellite ID — numbers marked in pucks.
» Elevation — the elevation of each satellite spread out along the concentric circles.
» The radius indicates the elevation.
» Azimuth — the azimuth of each satellite placed along radial angles.

» State — the state of the satellite marked and color coded for its state.

T Azimuth Hevation ] [ -E =]

GPS u GLO u B sBasu

Figure 25 Azimuth elevation

=2 It

Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights
Reserved. Page 47 of 120



Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

5.6. Scatter Plot

The Scatter Plot displays position points updated every second. The position points are
compared to each other in an axis in meters.

=

Navigation Lipdate Infa
ute: | | | Use Reflat: 3367085655 Samples:
Ref Lon: -117.653861
oop: | n L JLJ

Horizontal Emor: Offset:

|

|
SV Tracked: || a [ ] oRMsm [ | Em[ |
Set Ref. cerm) [ [nem[ ]

50m

25
15

33/ 3

5m

Figure 26 Scatter plot view

The “Navigation Update” pane displays the navigation update data, including the following

e UTC time,

e Latitude, Longitude, Altitude (HAE),
e DOP (VHDOPZ + VDOP?),

e Number of satellites in track.

The “Info” pane contains the following elements:

e A checkbox that allows user to specify if a reference position is to be used for
plotting,

e The reference position information (if a position is being used in plotting),

o 2DRMS error — this is the twice DRMS accuracy, with a 95% probability

e CEP error — Circular Error Probability

e Offset “E” and “N”: these fields indicate the offset, or bias, that has been calculated by
TelitView, to the Easting and North direction, respectively. The bias is from processing
from the position fix data, with respect to the reference position being used in plotting.
If the position data, on the average basis, has the bias as 0, and the antenna that is
feeding data to the GNSS module has the position is the true position to the reference
being used, these values should be zero, or close to zero.
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The Data Overview monitor displays an overview of some GNSS data:

T TelitView
Setup  Views Tools Commands Test Windows Help
=) u | 0o * £ 5 s|@
T Data Overview o B |3
& ime \titude Geoidal Sep  Latitude Longitude PDOP HDOP VDOP SVinView SVinUse Course Speed Mod

QTR 00:00:00 |0.000 | 0.000

01/27/2016 | 00:00:00 | 0.000 | D.0DD

01/27/2016 | 23:27:03 | 230.600 |-34.100
01/27/2016 | 23:27:04 | 230.600 |-34.100
01/27/2016 | 23:27:05 | 230.600 |-34.100
01/27/2016 | 23:27:06 | 230.700 |-34.100
01/27/2016 | 23:27:07 | 230.700 |-34.100
01/27/2016 | 23:27:08 | 230.700 |-34.100
01/27/2016 | 23:27:09 | 230.700 |-34.100
01/27/2016 | 23:27:10 | 230.700 |-34.100
01/27/2016 | 23:27:11 | 230.700 |-34.100
01/27/2016 | 23:27:12 | 230.700 |-34.100
01/27/2016 | 23:27:13 | 230.700 |-34.100
01/27/2016 | 23:27:14 | 230.700 |-34.100
01/27/2016 | 23:27:15 | 230.700 |-34.100
01/27/2016 | 23:27:16 | 230.700 |-34.100
01/27/2016 | 23:27:17 | 230.700 |-34.100
01/27/2016 | 23:27:18 | 230.700 |-34.100
01/27/2016 | 23:27:19 | 230.700 |-34.100
01/27/2016 | 23:27:20 | 230.700 |-34.100
01/27/2016 | 23:27:21 | 230.700 |-34.100

0.0000000 |0.0000000 |00 0.0
0.0000000 | 0.0000000 |00 0.0
336709083 |-117.6538433 | 0.0 0.0
336709083 -117.6538433 |13 0.8
336705100 |-117.6538433 |13 0.8
336709100 |-117.6538433 |13 0.8
336709083 -117.6538433 |13 0.8
336709100 | -117.6538433 | 1.3 0.8
336709100 |-117.6538433 |13 0.8
336709100 |-117.6538433 | 1.3 0.8
336709100 | -117.6538433 |13 0.8
336705100 |-117.6538433 |13 0.8
336709100 |-117.6538433 |13 0.8
336709083 -117.6538433 |13 0.8
336709100 | -117.6538433 | 1.3 0.8
336709100 | -117.6538433 |14 0.8
336709100 |-117.6538433 | 1.4 0.8
336709100 | -117.6538433 | 14 0.8
336705100 |-117.6538433 | 1.4 0.8
336709100 |-117.6538433 | 1.4 0.8
336709100 |-117.6538433 | 1.4 0.8
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Figure 27 Data overview

Data Chart

Data Chart window provides user selection control for several displays for some useful
information. The information display that have been implemented include the following:

o Average CNo

e Altitude (HAE)

e Speed

e HDOP

e Number of satellite in use

e Number of satellite SV in view
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e Latitude
e Longitude

The meaning of the data is straightforward.

The following figures illustrate the display of the average CNo and the satellite in use with
respect to the UTC time, based on the “Y:” dropdown list box, as shown.

T Data Charts o || = || &2

¥: [|average Cho ~| /% UTC Time - B

55

A4
13 #%
- L]

Average CNo

0
021272016 11:50:41 02122016 11:53: 1 0212/2016 11:56:20 0212/2016 11:55:05
UTC Time

Figure 28 Data chart view — the trace of average CNo

¥: [SVs In Use | -] % UTC Time - ﬂ

43

32

28

15

SVs In Use

=l — T —
10 |MP ]IF
- -

0
02NR2016 07:31:24 02152016 0732311 0215/2016 07:33:38
UTC Time

Figure 29 Data chart view — the trace of number of satellites in use
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Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights
Reserved. Page 50 of 120




5.9.

Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

Custom Messages Window

TelitView supports different kinds of products / modules that are offered by Telit GNSS in a
unified user interface. The Custom Messages window is a configurable message window for
convenient and flexible interface to customize TelitView’s message handling windows.

In this window, the user is provided with flexibility to customize different messages display
by adding messages as the message filter. The messages received by TelitView from the data
source will be displayed in this message window, in addition to the regular NMEA Monitor
window.

In addition, the user can also remove messages from the settings list to reduce the message
traffic into the window.

Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights

Reserved.

Page 51 of 120



Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

5.9.1. Access & Controls on the Window
> Menu: Views > Custom Messages
T Custormn Window E\@

Pause” button [n] - “Add” message
Custom view message settings A/ header as a target

Target message 5P STiv3DACC -

header/talker ID | “Remove”
SPSTM3DACC 575309764 .-80,-64,16400°2A I ™~ message header
SPSTM3DACC, 375877955.-96.-112, 16368711
SPSTM3DACC 575946143 64 -80, 16400723 as a target
SPSTM3DACC 575014338.-96.-112, 16400717

Filtered SPSTM3DACC 37608245248 -80, 16432727

— SPSTM3DACC, 576150754 80,112, 16352°1F

messages TM3DACC, 976218938, -64,-80, 16448723

SPSTM3DACC 376287123.-96 -48, 16400723

SPSTM3DACC 576355352 -80,-64,16432°2B
SPSTM3DACC 976423686,-80.-64,16368°29
SPSTM3DACC 576451818,-80,-96,16336°2F
SPSTM3DACC 576560091,-48,48,16352°2C
SPSTM3DACC 576628236.-64.-16.16400°29
SPSTM3DACC 576656482 -48,-64,16336°2C
SPSTM3DACC 976764703 ,-96,-64,16400°2B
SPSTMDRSTEP,15,1.64873.0.00105,0,0,1.000.1.000.1720
SPSTM3DACC 576832826,-64,-48,16368°25
SPSTM3DACC 576501060.-80.-80.16384°22

m

1

Figure 30 Custom message window and controls

The Custom Message window contains a collection of text boxes and two panes.

e Thetarget message header /talk ID:

This field is for user to enter a string of text as a message header. After being added to the
message list by clicking the “Add” button on the panel (see below), TelitView will parse the
text sentences or messages that TelitView is receiving and display them as the filtered
messages as long as the messages contains the text string as the message header (the first part
of a message).

e The “Pause” button:

User can click to toggle between pause and resume of update in the views of this window.

Note: Anytime the “Pause” button on the main form toolbar is clicked to “resume” from
“pause”, the “pause” of this button is released as well.
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e The “Add” button

User can click to add the text string in the “Target message header/talker ID” field to a
“checklist” of TelitView for this feature. The parsing and filtering for the message header will
not be in effect until the message header 1D has been added to the checklist.

¢ The “Remove” button

This is the opposite of the “Add” button - user can click to remove a text string in the “Target
message header/talker ID” field from the “checklist” of TelitView for this feature. Once a
message header has been removed, parsing and filtering for that message header becomes
none-exist.

Example shown in the screen capture:

Above screen capture illustrates that a NMEA message ID of PSTM3DACC (as the talker +
message type ID) is added to the “checklist”.

After message has been added to the settings, all messages that contain the message header
will be displayed in this window, along with any other messages that have added to the list
the same way.

Configuration of Custom Message Settings

For complete and detailed information on how to add, edit, and remove target messages from
the parsing list, please refer to the Section 7.3 Configure Message Headers for Customized
Display.

N
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0. Introduction to Tools Menu

The Tools menu contains the built-in tools in TelitView.

6.1. Replay of Data

The TelitView “replay of log file” feature carries out the following actions:
» Open a log file that contains the log data from earlier runs,
» Parse the data for valid messages, a.k.a. NMEA messages, and

» Display and update the view window with the result from parsing, as TelitView
would from receiving the messages through COM port.

The “Replay Data”, “Pause”, and “Stop” buttons have the same functionalities as the buttons
on the toolbar, respectively.

6.1.1. Open Log File for Replay
The access to open a log file is implemented in the Setup menu.

> Menu: Setup > Replay

T TelitView ﬁ

Setup | Views Tools

Comm Port

| é Replay |

|:| Dizconnect

Figure 31 Log file replay

After user has entered a valid location for the log file for replay, TelitView will locate the file,
open, and start to replay the messages contained in the log file.
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6.1.2. Control the Speed for Replay

> Menu: Tools > Replay Data

Tools | Commands Test  Windows  Help
]
u +  Replay Data » ‘ﬂr Slow
Pause | =  MNormal
H  Stop »  Fast

Figure 32 Tools menu
The replay speed is selectable with the following three options:

o Normal — the same speed as the original data update rate.

As the default, the replay file is read (on the second basis) all NMEA messages before the
next GPRMC message. And the screen is updated accordingly.

e Slow — the replay will be run at a half speed as in the Normal speed.
e Fast —the replay will be run at a various speed based on how the “Fast” is selected.

With respect to the Normal speed, the first “Fast” will replay the file at twice speed. Another
click on “Fast” will result in the replay at 10 times as fast. This is the maximum speed for the
file replay.

6.1.3. Pause and Resume

User clicks “Pause” button to toggle pause or resume replay.

6.1.4. Stop Replay

User clicks “Pause” button to stop replay.

s =l
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6.2. User Commands Manager

TelitView provides a highly flexible and user-friendly tool in the context of User Commands
File. This feature allows user to create user-defined commands, in the format of text strings,
in a XML file, and store these commands in a XML file. User can then load the commands
into TelitView and send a command string with a click on the command to a receiver.

> Menu: Tools > User Commands Manager > Load User Commands To Menu

Tools | Commands Test Windows Help

*  Replay Data y ELLE S 5@
Pause
B Stop
User Commands Manager s | User Commands (Mew/Modify)

DR Control Panel | Load User Commands To Menu l

EPO Host Manager
Auto-baud to NMEA protocol [

Figure 33 User Commands Manager

For more complete and detailed information about the User Commands File, including
loading and editing, etc. with User Commands (New/Modify) menu as shown in figure above,
please refer to the Section 7.4 Create and Maintain Commands Files.

6.3. DR Control Panel
> Menu: Tools > DR Control Panel
T DR Control Panel EIIEI
Gyro and Acc  Clear Cal
Wehicle Maoving State
OR Celibration Status Speed | 000|ms | 0.000|mn | 0.000]kmn
DR Calibrated
0Odo Gain Calibrated Headng [ 1362] deoree Lat
Direction Lon

Gyro Gain Calibrated

— DR Gyro Status DR Odometer Status
Gyro Offset v Delta Odo Count 0.000

Gyro Gain (s 0Odo Scale
Yaw Rate v Valid Odo

=
= [

Figure 34 DR Control Panel

W
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The DR (Dead Reckoning) Control Panel is the start point for user to monitor receiver’s
output data, send commands as they are pertaining to receiver’s DR specific states, status, and
performance related data.

Controls and Data Panes

The panel consists of the following panes

e Toolbar:

o  “Gyro and Acc” button: to bring out the Gyro and Accelerometer panel
o “Clear Call” button: to send a command to clear the DR calibration.

o Data panes:

DR Calibration Status: indicates the calibration status bits for the following DR variables of
calibration:

o DR
o Odometer gain

o Gyro gain
o Gyro offset

Vehicle Moving State: indicates some variables of vehicle moving states such as the
following:

o Speed (including meter/second, mile/hour, and kilometer/hour)
o heading
o direction (forward or reversed)
o Latitude and Longitude as reference
DR Gyro Status: indicates some variables of Gyro status such as the following:
o Gyro offset
o Gyro gain
o Yaw rate

DR Odometer Status: indicates some variables of vehicle Odometer Status such as the
following:

o Delta odometer count
o Odometer scale

o Odometer valid flag
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6.3.2. Gyro, Accelerometer, and Odometer Data Panes

The Gyro/Accelerometer/Odometer panel is brought up by clicking the “Gyro and Acc”
button on the toolbar DR Control Panel.

T DR Control Panel

“Gyro and Acc” =G],rro and Acc  Clear Cal
button

DR Calibration Status
"] DR Calibrated

["] Odo Gain Calibrated

Figure 35 Launch DR Gyro and accelerometer data view

T DR3D Gyro & Accelerometer DataView EI @
Gyro Data Accelerometer Data] Odometer Data
CpuTime RawX RawY RawZ “|| CpuTime RawX RawY RawZ *|| CpuTime Odometer -
1145215936 -17 -14 32 1145218435 £4 48| 16336 1150174689 0
1145288041 -22 7 47 1145286593 -48 64| 16304 1150242876 0
1145356305 -18 7 38 1145354784 £4 54| 16400 1150311046 0
1143424437 21 -7 20 1143422965 54 -56| 16304 1150379158 0
1145452580 -56 8 -16 1145451114 54 -80| 16368 1150447287 0
1145560873 -50 -12 -22 1145555359 -48 64| 16368 1150515633 0
1145625059 -17 -23 32 1149627571 -48 64| 16368 1150583806 0
1145657341 -42 13 12 1145695833 -112 -112| 16400 1150651953 0
1143765535 -25 8 -23 1143764043 -96 64| 16336 1143765555 0
1149833861 -37 15 3 1149832282 -80 -112| 16384 1143833861 0
1143501306 -4 -1 22 1145500386 48 -112| 16368 1143501306 0
1145970148 -27 -2 16 1145968607 -80 -48 | 16400 1145970148 0
1150038258 -27 -13 24 1150036815 -112 96| 16336 11500382598 0
1150106571 -1 8 15 1150105094 -43 -80| 16384 1150106571 0
1150174689 -15 8 IHE 1150173215 -80 -48| 16432 || 1150174689 0|=
1150174685 -15 ] 18| 1150173215 -80 48| 16432 | 1150174685 0|
4 ( )
Raw X ! Raw X !
Raw Y : Raw Y f
Raw Z 1 Raw Z o e il
e(IODD} -20 -18 E: 18 30) eﬂm} -20 -12 -4 4 12 20)

Figure 36 DR 3D Gyro & Accelerometer data view
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e The “Pause” button:

User can click to toggle between pause and resume of update in the views of this window.
Note: Anytime the “Pause” button on the main form toolbar is clicked to “resume” from
“pause”, the “pause” of this button is released as well.

e The Gyro, Accelerometer, and Odometer panes:

This panel displays the updates of the following data in three panes respectively:
o DR Gyroscope
o DR Accelerometer

o Odometer

e The bar charts for raw data from Gyro and Accelerometer:

Two horizontal bar charts are implemented for the raw data of X, Y, and Z as defined in the
Gyro and Accelerometer data, respectively. They provide the user graphics representations of
the data updates as they come in.

If a hand-held receiver is used and maneuvered, the change of those variables are shown in
the graphics.

6.3.3. Command to Clear DR Calibration

User can send a command to the receiver to cancel calibration by clicking the “Clear Cal”
button on the toolbar DR Control Panel.

T DR Control Panel — “Clear Cal” button
Gyroand Acc  Clear Cal4— |

DR Calibration Status
"] DR Calibrated

["] Odo Gain Calibrated

Figure 37 Clear DR calibration

The effect of this command is the DR calibration states in the receiver will be cleared. And
this state changes can be seen from the output of the receiver.

If the DR calibration clear requires reset to the module, an information box will pop up to the
user.

User will click “OK” to acknowledge the information, but determines whether or when he
will reset the module, by sending a “Reset” command or conducting a power cycle.
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N
Information lé]

DR-calibration Clear won't take effect until the module is reset,
by sending command or conducting power cycle

Figure 38 Prompt on Clear DR-calibration

6.4. MO-DR Control Panel

> Menu: Tools > MO-DR Control Panel

T MEMS-Only DR Control Panel [=2a]
IMURAW Data
I (000 | 678N svov | SN [~
IMUAT Pane IMUIT Speed Pane
1_Ghours | 33915 11_GGAFdnd 3 21_GhAngle 90.0 31_TempHdgSt 1 41_fmAz 0.00
2_GFixValid A 12_GSAFxSt 3 22 GNCov 56 32_0OdoCal 1 42 mby 042
3_GSpeed 00  13_GGANmSat 15 23_GECov 70 33_GyBiasCal 2 43Vm 0.00
4_GCourse 00 14_HDop 09 24 GVCov 53 34_StopCondi 1 44 dmpy 059
5_VelMeter 0.0 15_PDop 1.7 25 S5pdPulse 1] 35_VehStopCond 1 45_Dirfxis 3
6_DCourse | 1105  16_VDop 14 26_Rearlnf 0 36_GSpdval 002 46 mAz2 002
7_PHeadg | #2610 17 GDop 20 27_ARGylsVal | 00 37_GPSHdPEr 1 47 miy2 001
8 Distance | 000 18 _EmpE 47 28 DROdeS | 105 38_Version 083 48_dmGSpd1| 000
9_VapGah 004 19_Majfds 70 29 OffsetZ [ 39_dmGSpd a0 49 DenCalPit| 0.00
10_HGPGap 8261  20_Minfds 56 30_DRHdgGab | 0.00 40_OffsetAy <1212 50_DenCalRoll| 0.00
52_AngRadRoll| 36.0 51_AngRadPit | 0.00

53_Snrfwgint 10
54 PrssHps 0.00

Figure 39 MO-DR Control Panel
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6.4.1. MEMS-Only Gyro Data Display

T MEMS-Cinl ontrol Panel

Coumnes >
3D [0DO | Gyro

Figure 40 MEMS-Only Gyro Data Display

Go to IMU Gyro data view

T MEMS-Only DR Gyro DataView = EoN =<
uTC Count Bao T Barometer Mems T Gymo_X Gyro_Y Gyro_Z Ao X Acc Y Acc_Z -
84225 8 6054 4145458 55 383 633 439 278 342 17689
84225 10 6053 4143422 55 348 639 430 268 239 16437
84225 12 6053 4143505 52 383 625 426 300 kY 15734
84226 14 6052 4143506 52 436 613 423 403 47 16637
84226 16 £054 4145350 55 365 628 428 256 333 15756
84226 18 6053 4145435 53 415 610 424 285 366 16210
84226 20 6055 4143266 53 424 611 43 420 324 17418
84226 2 6054 4143421 55 359 534 438 308 344 17250
84226 4 6053 41453529 52 354 -629 43 332 314 16094
84226 ] £055 4145613 56 353 A1 432 267 354 15513 T
84226 8 6054 4145486 55 43 621 428 443 327 17028 ‘E
84226 10 6051 4145533 57 393 625 439 270 370 17794 t
z o L]
% Gyro Z
: SERNARNEEE
4 7 L S3TB55432-1012345687858
E
E -z
= oz -y
£ 2 -l
= - -
<0 H 3 7 B 4 =2 2 1 o 1 2 3 4 s

Figure 41 MEMS-Only Gyro Dataview
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6.5. EPO Host Manager

> Menu: Tools > EPO Host Manager

The EPO Host Manager window provides all user interface and the controls the
functionalities for the EPO feature.

The following figure illustrates how it looks like after launching the EPO Host Manager.

EPO File Source Setup

. EFO File Attrbutes
() EPO Server  Server Address

http.//epo telit.com GPS

User Name Password File Name GLONASS [T Generation
slkdfa SkdZowed5 MTK30.EFO File Size (bytes)
® Local EFO Fie {defaut) E] Val Len Segmerts
C:\Wserstluowa'\Downloads\EPO_GPS_6h DAT Exension Days
Assistance Data EPC Update Status
Days #of Epoch EPO DLL inttiglized... |
Query EPO Status Weekhum TOW
First Epoch I
EOERY Final Epach
Cmt Min E..
Crmit Max E...
Tt

Update EPO Abort

Host Aiding (auto-send when restart)

[C] System time Lat Lon

[ Ref Posttion 33670678 -117 653925
[7] Host EPO

S

Figure 42 EPO Host Manager Window
Basically the window is divided into upper half and lower half panes:
e The EPO File Source Setup to set up and get the EPO file

e The Assistance Data to transfer EPO and other assistance data to the client module

I (G
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6.5.1. EPO File Source Setup

“EPO File Source Setup” pane in the upper half of the window:

1) Specify all necessary information, such as URL name, credentials, and EPO file
selection to access a remote EE server, and download the file from the remote EPO
server.

2) Alternatively, user can load from an EPO file that has been downloaded earlier and
stored at a local media.

6.5.2. Get EPO

After a user selects an EPO source from above — either the remote EPO server with the user-
entered credentials, or the local directory, he can click the “Get EPO” button to have EPO
Host Manager go to the correct source location to load the file.

After the EPO file passed validation check and is loaded into a temporary memory, the basic
information values will be displayed in the data pane, indicating the file size, segment, and
extension days, and the file is ready to be transferred to the client module.

6.5.3. EPO Data to GNSS Module Transfer

There two methods of transferring EPO data to the client module:

» Use EPO-II method: “Update EPO” button transfers the EPO data to the client
module

» Use Host-EPO method: Transfers the EPO data using a combination of

o Systemtime
o Ref Position
o Host EPO
The Host-EPO is initiated when a reset or power-up message is received by the host.

6.5.4. EPO Status Inquiry and EPO Clear

“Assistance Data” pane in the lower half of the window:
e Query EPO Status and Clear EPO
The buttons to query the current EPO-I11 state in the client module and clear the EPO data.

Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights
Reserved. Page 63 of 120



Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

6.5.5. EPO Update Status Display

“EPO Update Status” pane in the lower half of the window:
o Displays the activities during the EPO transfer process (EPO-1I and Host-EPO).

The detailed description can be found in Section 8.EPO Feature.

6.6. Auto-baud to NMEA protocol

This feature scans through different baud rate values (4800, 9600, etc.) and attempt auto-
detecting the correct baud rate to make serial connection to the GNSS module’s UART port.

This feature can be used when the current baud rate is not known to user and would like to
have TelitView to auto-detect it on the currently connected port.

s =l
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7. TelitView Features

7.1. Identify Product

Some products (hardware modules and their firmware) offered by TelitView GNSS use the
same set of software command interface or protocol. The user has to specify the types of the
products that TelitView is going to be interacting with.

7.1.1. Access to the Product Selection Dialog Box

> Menu: Setup > Products

The Product Selection dialog box is for the user to enter selection for the product.

Once the user clicks the OK button on the dialog box, the selection will be used by TelitView
as the specifier that dictates the corresponding interface / command set.

There are other ways to access the same Product Selection dialog box.
e Connect to Receiver:

Please refer to the Section 3.2 Connecting TelitView with a GPS Receiver through a COM
port for description.

e Session & Connection Profiles:

Please refer to the Section 7.7.2 Sessions & Connection Profiles for description.

I
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7.1.2. Product List

The way the selection of a product has been changed; the list of modules has been enhanced
from the last release of TelitView.

' Product Selection @
Module Select: Chipset:
’NDN—SF'ECIFIC "] [NON—SF‘ECIFIC v]
Telit Modules:

>

o]

Figure 43 Product selection dialog box

There are two methods provided for the user to make selections:
» Module type — The names of Telit GNSS Modules (shown in the left side box).

» Chipset type — The names of the GNSS chipsets that are found in modules (shown in
the right side box).

Note: The box area below the Chipset Type selector will list the modules that contain the
chipset.

The two methods will be illustrated in the following description.
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User’s Select from Module List
If a user knows the module name, he can select it from the “Module Select” list.

All Telit modules will be listed under the “Telit Module” dropdown list, as shown.

Product Selection @

Module Select: Chipset:
[NON—SPECIFIC '] [NON-SF‘ECIFIC v]

NON-SPECIFIC Telit Modules:
JF2

JN3
SC872-A
SEBG8-A
SEBGB-AS

SES68-V2 ,
SES68-V3 Product Selection ==
___SER73

SE276-A
0
fiew oraan O

[ 1
View SL869 E E
g

Module Select: Chipset:

/v(suaawz ~ | [mT3333 -

SLB69-3DR
seet 5| B69-DR E
_ SLBBST

kN 51.869-V2 3 Fix
T 5L869-v2s D .

—— SL865-V3

— SL86E-VaT GPS/5FS m oK
—sLa71 - -
tu SLB71-S |

Figure 44 Product Selection

Anytime a module is selected (any module other than the “NON-SPECIFIC”), the
corresponding chipset name, as well as all the modules in the chipset family will be displayed
in the right side boxes.

In the above example, the selection of SL869-V2 module will bring up the chipset MT3333 in
the “Chipset” dropdown list, as well as other member modules that contains the MT3333
device. Inthe list, the selected module, SL869-V2, is also highlighted.

User may click “OK” to complete the product selection.

User’s Select from Chipset List

If a user chooses to start from a chipset name, he would choose a chipset from the “Chipset”
list.

All chipset types will be listed under the “Chipset” dropdown list, as shown below.
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Product Selection @
Module Select: Chipset:
NOMN-SPECIFIC - ‘NON-SFECJF]C hd '
SiRFstar 4=

SiFFstar e BO1
SiRFstar e BO2
Teseo 2
Tezeo 3
MT3333

Figure 45 Chipset list

Anytime a chipset type is selected (any type other than the “NON-SPECIFIC”), the

corresponding chipset name, as well as all the modules in the family based on the chipset will
be displayed.

| Product Selection @

Module Select: Chipsget:
| [SRFstar 4e ~|
Telt Modules:

JN3
SEE80

Figure 46 Modules under a chipset selection

In the example below, the device “SiRFstar 4e” is selected in ”Chipset” dropdown list, the

selection will bring out the module names that are in the same chipset, as shown : JF2, IN3, and
SEB880.

Notice that “Module Select” field is empty and it requires user to make a selection from the
member modules under the Chipset.

Product Selection @

Module Select: Chipset:
N3 | |[SiRFstar 4 ~|
Telit Modules:

JF2

SE&30

Figure 47 A Telit Module is selected based on chipset
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Once user clicked the selection, (i.e. “JN3”), the “Module Select” field will be populated with
the module name, as shown in the figure.

User may click “OK” to complete the product selection.

7.1.5. What is expected from the Product Identification

The “NMEA Monitor” view is the primary interface the user interacts with the GNSS receiver
connected to TelitView. The product selection will trigger the NMEA Monitor to change its
frame color if the window is already open.

The product type will also be shown on the title bar of the window, as indicated in the figure.

A ]
T NMEA Monitor (= T NMEA Monitor [Module: SL869/5L869-DR] [E=RER

) (=)

£00

™ RX

$GPGSV,3,1,12,01.41,305,40,03.00,213,11,44,266,41,1
$GPGSV.3,2,12,14,37.044,38,19,12,228,26,20,17.306..2
$GPGSV,3,3,12,23,08,252,33,25,10,073,,31,63,143.38.3
$GLGSY,.3,1,12,66,13,302,,73,12,179..84,14,216,,.68,.00.1
$GLGSY.3,2,12,86,18,311,,70,46,342.43.86,18.315,31.8
$GLGSY.3,3,12,79.40,048, 69,38.062.45,85,28,263,38.7
$GPRMC,172252.000,V,3340.2524,N,11733.2310.W.0.C
$GPGGA, 172252.000,3340.2524.N,11733.2310,W.0,00.
SGNGSAA 99.088.0.950

SGNGSAA 9.089.0.89.0
$GPGSV,3,1,12,01.41,305.40,03.00,213,,11,44,266,41.1
$GPGSV,3.2,12,14,37,044,38,19,12,228,26,20,17,306,.2
$GPGSV,3.3,12,23,08,252,33,25,10,073,.31,63,143,39.3|
$GLGSY.3,1,12,66,13,302,,73,12,179..84,14,216,,68.00,|
$GLGSY.3.2,12,86,18.311,70.46,342,43,86,18.315,31.8
$GLGSY,3,3,12,79.40,049, 69,39,062,45,85.28,263,39.7
$GPRMC,172253.000,V.3340.2524,N,11735.2310.W,0.0
$GPGGA, 172253.000,3340.2524,N,11733.2310,W,0,00,
SGNGSAAT,........99.0,98.0,89.0
SGNGSAAT,........99.0,98.0,89.0
$GPGEV,2,1,12,01.41,305.40,03.00,213,,11,44,266,41.1
$GPGSV,3,2,12,14,37,044,38,18,12,228,26,20,17,306,.2
$GPGSV,3,3,12,23,08,252,33,25,10,073,.31,63,143,38.3|
$GLGSY.3,1,12,66,13,302,,73,12,179.,.84,14,216,.68.00,1—
$GLGSY,3,2,12,86,18,311,,70.46,.342.43,.86,18.315.318 ~

m

The main form title bar will be updated with the product identifier as well.

. e

T TelitView [Module: SL869/SL869-DR]

Setup View Tools Commands Test Windows Help
= 8 LRI B 20 w ¥ 3 §E L2

I

T NMEA Monitor [Module: SL869/SL869-DR] ]

Figure 48 NMEA Monitor before and after a product selection
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If the NMEA Monitor is launched after the product has been selected by user, the later opened
window will also have the frame color changed.

Once the product selection is made, the command set is automatically loaded into the program
that is product-specific for use.

The command set is available under the menu Commands > Basic Commands.

Note: It is the user’s responsibility to make sure when commands and run tests are sent, the
correct product type (module name) is identified to the program.

7.2. Log Data to Files

> Menu: Setup > Start Log

Fag

T TelitView [Module: SL

Setup | Views Tools
Cormm Port

== Replay

Disconnect

= Start Log ] |
Stop Leg

T Log Data Configuration EI =] @I

[] Al Serial Data
CDatalog i

[ NMEA messages ] [ PCTimestamping

ChDatalog'NewNMEAFile bd =

Figure 49 Log data configuration dialog box
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Log File Types

Two log file types are provided for user to log input / output data at the COM port, with the
following specifications:

1) All Serial Data

When enabled, this file type logs the data as byte stream, which means the data can be text
lines that include the standard NMEA as well as the proprietary NMEA messages.

The data can also be any binary data bytes that are often used for debugging purpose.
Because this type of data does not conform to any standard known to TelitView, TelitView
does not examine data and distinguish the contents, rather simply log them into a file.

2) NMEA messages

When enabled, this file type will log the data that conforms to the NMEA standard - sentences
starting from a ‘$’ character and ending with a valid checksum after a “** character.

The two log file names (with paths) are set separately; they are not allowed to share the same
file name in the same directory.

PC Time stamping

This feature allows a user to insert a timestamp mark to each message (NMEA sentence) that
is logged in the file type of NMEA message.

The following examples show the effect of PC time stamping.

$GPGSA,A,3,15,18,27,19,21,24,22,14,,,,,1.15,0.81,0.82*04
$GLGSA,A,3,88,65,81,87,66,,,,,,,1.15,0.81,0.82*1D
$GPGSV,3,1,10,22,64,322,29,14,56,193,30,18,52,042,33,21,51,112,34*74
$GPGSV,3,2,10,51,49,161,31,27,47,275,25,19,30,308,26,24,21,076,19*7D
$GPGSV,3,3,10,15,11,043,18,04,03,308, *7E
$GLGSV,3,1,09,88,72,213,19,65,53,007,18,66,44,275,28,81,38,324,29*6E

Figure 50 Log file with no timestamping

13:46:17:565,5GPGSA A,3,15,18,27,19,21,24,22,14,,,,1.14,0.80,0.81*07
13:46:17:565,5GLGSA A, 3,88,65,81,87,66,,,,,,,,1.14,0.80,0.8 1 ¥ 1E
13:46:17:566,5GPGSV,3,1,10,22,64,327,38,14,59,193,28,18,51,045,33,21,49,115,28*70
13:46:17:566,5GPGSV,3,2,10,51,49,161,30,27,47,272,30,19,32,306,28,24,21,074,24*7 1
13:46:17:567,5GPGSV,3,3,10,15,09,043,16,04,05,309,16*79
13:46:17:568,5GLGSV,3,1,09,88,69,207,23,65,51,010,30,66,45,279,32,81,41,322,21*60

Figure 51 Log file with timestamping

Note: This feature is only available for the Iog file type of NMEA messages
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7.2.3. Start Log

The two log files are handled independently and separately. After setting either one file (or
both), a user can click “Start to Log” button, to actually start logging.

Once data logging starts, the title bar in TelitView will show the logging file status, as below.

T TelitView [Module: SL871/5L869-V2] [Log File Open: C:\Data Log\NewNMEAFile.txt] [Log Comport Data Open: C:\Data Log'\RawDataFile.txt]

Tetup . Wiews  lools  Commands  Test . wondows - HeEp
SR o N =T K EL

A EET =
o = S W

T NMEA Monitor [Module: SL871/5L860-V2] [r=lg

RX

I SPMTKALM,55,1,2,3,4,5,6,7.9.10,11,12,13,14,15,16,17.18,19,20,21,22,23,24,25,26,2
$PMTKDBG.18772336.1.1.1,1.0.0.0.1,1.0.0,0.0.0.0,0,0.0.1,1.1.1.1,0.1.0.0.0.0.0.0.0.00
$PMTKDE2,0000,0000,0000,0000,0000,0000,0000,0700,0002.81,0282.69,0281.67,
$GPTXT.01.01.02 ANTSTATUS=0K*3B

SGNGGA.214108.000.3340.2542,N,11735.2305,W,2,13,0.81,.302.2,M.-34.1.M.0000.4

Figure 52 Title bar shows the status of logging file

7.2.4. Stop Log

T TelitView [Meodule: SLBE6S/5L869-DR] [Leg File Of

Setup | Views Tools Commands Test

Comm Port —> Bl | S5 [T W
Stop Log !|' == Replay 4
Dicconmect le: SL869/5L869-DR]
e
|ﬂ Stop Log |
Products
Sessions
Convert
Exit ‘ﬁF’STME

Figure 53 Stop log
User can click the “Stop Log” button either from the “Setup” menu or the icon on the toolbar,
to stop logging process.

After data logging is stopped, the title bar in TelitView will display the updated logging
status; showing that the log files are closed.
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7.3. Configure Message Headers for Customized Display

7.3.1. Message Header

A messages header is defined as the first field of a text line received by TelitView from its
data source. The “first field of the” text line is defined as the text present before the first
comma “,”” encountered in the received text line.

The user should only use the first part of a text string, before the first comma, as the message
identifier for the program to parse and display. TelitView will not parse the text line as a
whole for this purpose.

7.3.2. Add Message to Settings

The user may use one of the following methods to add a message header to the window as the
settings:

1. Manual typing
2. Typical “copy & paste” operation (from the Clipboard)
3. “Grab and enter” from NMEA Monitor window

If the user would like to set a particular message shown in the NMEA Monitor window and
add it to the settings, the user can make the data traffic pause first, then “double-click” the
message. The program will automatically grab that line, trim it to get the first field, and fetch
it to the “Custom view message settings” field.

Note: The user needs to click “Add” button in order to set or enable this new message header
to take effect.

Remove Message from Settings
The user can elect to remove a message from the settings by first select it from the list (to
place it on the settings field”, then click “Remove” button.

7.3.3. Persistence of the Settings

The settings, after configuration above, will be automatically saved. The same setting will be
reloaded on the next launch of the program.
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7.4. Create and Maintain Commands Files

TelitView provides methods to send commands or messages to connected receivers with
extended flexibility.

These methods and flexibility are implemented with two text files in XML format:

¢ Basic Commands

This file contains contents created as the default, built-in by TelitView. They are product
specific.

¢ User Commands

This file contains contents created and maintained by the user. They are custom created and
product and customer specific to meets all kinds of testing and control purpose for the
customer.

7.4.1. Contents of the Commands Files

Both Basic Commands file and the User Commands are in XML format.
The following is an example of how a command file looks like.

[ =

I 2] CATelitViewWL\Tel 2 ~ & X o]

2 CATelitViewWL\TelitV... |

8 &

<?xml version="1.0" encoding="UTF-8"7=
<!1--Telit GNS5: Module SL869-V2: Version 00.00: MFG MTK-->
- _=UserCommand
- <UserCommandz
| <Descripticn>Perform a COLD start</Description>
zNMEACommMand=$PMTK103 </NMEACommand:>
= /UserCommand =
- <UserCommandz
<Description>Perform a WARM start</Description>
<MMEACommand=%$PMTK102 </NMEACommand
=/UserCommand=
- <UserCommand=
< Description>=Perform a HOT start</Description=
<MMEACommMand=>$PMTK101 </NMEACommand=
</UserCommandz
=fUserCommands:=

Figure 54 Example of commands file

Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights
Reserved. Page 74 of 120



7.4.2.

7.4.3.

Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

A Command file of XML format contains the following components:

e Command description

Example: “Perform a COLD start”.

¢ Command text line

Example: $PMTK103

How TelitView Handles the Commands Files

By design, TelitView handles the two files differently.

Basic Commands File

This file is created and installed by the TelitView Installation package. The installation
process creates the folder Basic Commands in the installation folder, together with the
TelitView executable.

o This file is not intended as editable by a customer.

o This file is automatically loaded into TelitView every time user select a product /
module type (from the Product Selection dialog box).

User Commands File

This file is created and loaded by the user.
o This file is created and maintained by user.

o Because it is in XML format, an XML editor program or alike is required to create
and edit this file. TelitView provides a user interface to enable the user to create and
edit entries in this file.

o This file has to be loaded by user.
Create User Commands (in User Commands File)

User the User Command Manager

> Menu: Tools >User Command Manager >User Commands (New/Modify)
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T TelitView

Setup  View Tools Commands Test Windows Help

== | N } 2 W ¥ 3
T User Commands EI@

Index Command Description NMEA. Command

CH W e
|5 v s | @

m

File

] | 1 3

State: Data source disonnected

Figure 55 User Commands Editor

The User Commands window (or editor) provides the following boxes and buttons to enter /
edit each user command entry, and save into a disk file specified by the user.

> User starts to create a user command by clicking the “New” button
For each entry of a user command, it has three fields:
3. “Index”:
An index count managed by TelitView.

4. “Command Description”:

A text string that serves as a descriptive title for the command. This command description
appears on the user command list after the user elects to load them.

5. “NMEA Command”:

A text string for an actual command string (or sentence, message) sent to the receiver.
g58) |

e
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NMEA Command Syntax

These commands strings are proprietary NMEA messages — they start with “$”, and may
contain none or multiple delimiters “,” to separate each parameter fields if applicable.

Note: These command strings are the raw data only — they are not expected to include the
checksum at the end of the command string here.

Save User Commands to the User Commands File
After the user creates the user commands, use the “Browse” and “Save” the commands to a
disk file in a folder with a file name the user knows where to load from.

7.4.4. Access to Commands (Provided with Commands Files)

Load Commands

The Basic Commands file is loaded automatically by TelitView every time the user selects a
product type from the “Product Selection” dialog box.

The User Commands file has to be loaded by user from a folder.

> Menu: : Tools >User Command Manager >Load User Commands to Menu

Access to Commands

The commands provided through the Basic Commands file and User Commands file are
accessible in the same menu:

> Menu: Commands >Basic Commands

> Menu: Commands >User Commands

They are shown in the two figures below.

N
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LB v 3 —

W‘ Test  Windows | Help Commands I—TESt i
- Basic Commands  » = 55 |1 | & & & @
| Basic Commands  » Initialize GPS position and time =

User Commands 3 Clear all ephemerls data User Test command 2 »

[ User Commands 4 | User Test commandl  »

Dump ephemeris data

* ¥ v

Load ephermneris data

Teggle MMEA cutput ON and OFF
Perform a COLD start

Perforrn a WARM start

Perforrn a HOT start

Perform a system reset

Reset GPS5 engine

* ¥ v ¥ ¥ v v

Enable/disable 2-D acquisition fixes
Get GMSS Library version

Toggle SBAS feature ON and OFF 3
Enable/disable STAGPS engine 3
Set GNSS constellation mask 3

-

Figure 56 Access to commands

7.4.5. Send Commands

The Basic Commands and User Commands provide a flexible way for the user to create and
use commands. Sending the commands across is implemented through the message “hub” for
receiving / sending messages — that is, the NMEA Monitor window.

7.5. Configure Reference Position

A reference position is a position, specified as a set of Latitude, Longitude, and Altitude
values used by the program as reference on which the Scatter Plot is drawn.

7.5.1. How to Configure TelitView to Use a Reference Position

e Use First Position as the Reference

As the default configuration, TelitView will use the first position fix (using GPGGA message
it received as nominal) as the reference position. When its Scatter Plot is open and the axes
are drawn on the window, the origin of the axes is positioned as the reference point.

e Use a User Entered Position as the Reference

Additionally, the user may elect to configure the program to use a reference position entered
and saved.
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e Selections in the Box
> Menu: Tool > Set Reference Position.

The format is a pure decimal value for the latitude, longitude in degree.

=
ot Reference Position ] @

Reference Position Setup

Format: +f—** %kkxikik

Latitude 33.670801
Longitude -117.652815
Set as Default

[7] setto use now
["] SavelUpdate

[ ok | [ canee

Figure 57 Reference Position

e Set as Default

This selection enables the program to use the position every time it starts, and to draw the
position on the Scatter Plot window.

e Setto use now

The selection sets the program to use this position once the user clicks the OK button.

Without this item being checked, on exit of this dialog box the new position will not be used
immediately. The position used on the next TelitView launch depends on whether the “Set as
Default” is checked, and whether the setting “Save/Update” is checked on exit of this dialog
box.

e Save/Update

The setting data is saved by TelitView and is available the next time TelitView is launched.

Without this item being checked, on exit of this dialog box, the new data will not be saved
and will not be persistent.

e Data source as the reference position

If the Host-EPO feature is to be used, as described in Section 8.2.2 Host EPO (Host-EPO
Method), 3 Host EPO, this window is the place to set up the reference position.
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7.5.2. Choose Whether to Use Reference Position for plot

If a reference position is available to the program, the “Info” panel in the Scatter Plot
indicates whether the reference position is used or not.

Indicator whether the
reference position is to
be used or not.

T Scatter Plot E"E
Navigation Update Info
uTC: Lat: Use  Reflat: 13670293
DOP: Lon: Ref Lon: -117.653893

SV Tracked: Alt: Horizontal Error: {m) 2DRMS
Set Pos as Reference Samples:

4 | i

State: Connected [COM31, Baud 9600]

Figure 58 Use of reference position in Scatter Plot

First of all, the “Use” check box is a status indicator, showing whether the available reference
position is being used or not. From the “Reference Position” dialog box, if the user has the
checkbox of “Set to use now” checked and press OK, this checkbox is expected to show that.

The “Use” check box can also be used as a command to “set” whether to use the available
reference position or not. By clicking it, the plot will toggle between using the reference
position and not using it.

Note: Every time such a configuration occurs, the existing plot will be cleared and a plot will
start over again.
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7.5.3. Use a Current Position as the Reference

Inside the Scatter Plot “Navigation Update” panel, the user may elect to use a current position
as a new reference the plot will be plotted upon. This feature is implemented with a button
click on “Set”.

Once the “Set” button is clicked, the Scatter Plot data will reset and the current position, in
form of latitude and longitude, will be used as the reference point for plot from this point
moving forward.

Also, the Reference Position dialog box will be brought up for user to configure how the new
position data will be used, the same way as the menu selection:

> Menu: Tool > Set Reference Position.

7.6. Setup and Run Looplt! Test

To easily run repeated tests, TelitView provides a test suite called Looplt! Test.

The most fundamental test is the Test Mode “0: Default”. It is a TTFF oriented - a repetition
of resets wherein the user can specify basic parameters to run a repeated test.

> Menu: Test > Looplt! Test
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Reset type: HOT RESET -
1: TTFF Sec=0.90

Activity: | Next Reset .J
Reset type: HOT RESET

2: TTFF Sec=0.90 2

Mew test session started
Stats: | 1: TTFF Sec=0.80
2: TTFF Sec=0.90

Close

Figure 59 Looplt dialog box Delay sec for the

current cycle

As seen from the left panel, the parameters include the following:
e Thetest type

o Repetition (Cycles)

e Nav seconds

e Timeout (Sec)

There can be other types of tests that can be developed, under different test modes, to support
various testing purpose.
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7.6.1. Insert Nav Seconds

User may insert some delay seconds after a position fix has been reached, before the next
cycle of reset kicks in. This delay will not take place if the receiver is not in nav.

User may elect to use one of the three methods to insert the nav seconds:

¢ The checkbox “Rand”:

Inserts the delay seconds generated randomly by the program, with the range [0...30]
seconds.

e The checkbox “OnWard":

Inserts the delay seconds that goes in step onward, with the range [0...30] seconds.

e The default

Inserts the fixed value for the delay seconds specified in the “Nav Seconds” field.

7.6.2. TTFF Test Stats

Test result statistics can be seen on the right side panel, which includes:
e Maximum TTFF
o Average TTFF

e The number of Timeouts

The meaning of each parameter is self-explanatory.
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Create and Use Sessions with Profile Feature

The session elements are the implementation in TelitView application that allow running of
multiple instances of the program on a same machine. Each run of an instance of TelitView is
always within a context of a “session”.

The session feature compartmentalized variables in the setup and execution within a session-
specific directory in the computer’s hard drive. Each session on which TelitView is running
will retrieve and store its own variables and setups. Multiple instances of run at the same time
by the application will not cause conflicts on the setups and variables.

What is a Session

First and foremost, each session is identified by a session identifier, a Session ID.

A session ID is a numerical value from 0 to a maximum number. Currently the maximum
number of session is 20, which means, the valid range of session ID is between 0 and 20
inclusive. Any number larger than the 20 will be rejected by the program.

In addition to the session ID, the following elements are components of a session:

e Description:

A text field that provides a “memo” style writing area. It is for user to enter brief text
information to describe about the session, its key connection parameters, etc.

e COM port:
A COM port name for serial connection.
e Baud rate:

A baud rate for serial connection.

e Telit Module:

A module type identifier.
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7.7.2. Sessions & Connection Profiles

Access to the Session Configuration dialog box:

> Menu: Setup > Sessions
Setup | View Tools Commands
. Comm Port k=) =
== Replay
|:| Disconnect
EJ Start Log
Stop Log
Products pend CR
| Seszions
Exit Rx Messages

Figure 60 Launch the session feature

The Session Configuration Dialog Box

The Session and Connection Profile dialog box is illustrated in the figure below.

lhs_Es
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T Session & Connection Profile Configuration @

J

O 00600

L In Use COMport |COM28 ~|¥ <]

— TelitModule [sL869/5L869-DR v

Session and Profile Setup

Session|D  Description
- TelitView: The Default Session! - <

Plete [[] Update Session Profile <

{Cbncel] [ Run ]

6 obeot

Figure 61 Session & Connection profile configuration

Fields of the Session and Profile

Refer to the Session Configuration dialog box, for the following fields:

1. Session ID;

A dropdown list and editable field to allow user to choose a session from the list, or enter a
value as a new session ID to add.

2. Description:

An editable text field to allow user to write a brief description as a memo to indicate the key
parameters for the session, the purpose, etc.

This field is also a dropdown list that contains the descriptions of the existing sessions that
have been created by user, and they are available as reference.

3. COM port:

A list of COM ports found available on the machine.
User clicks the arrow key to select a port to be used for the session.

The checkbox on the right side of the COM port: a checked state is to indicate the port is
available. A COM port can be defined in one or more sessions and it will be found in the list,
but the port can be at a busy state at the particular time.

4. Baud rate:

A list of standard baud rates that can be used.
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User clicks the arrow key to select a baud rate for the session.

5. Telit Module:

A list of the Telit module types supported by the TelitView program.
User clicks the arrow key to select a module type for the session.
6. Update Session Profile:

A check box that user clicks when he wants to use the field values to have the session profile
updated when he clicks the “Run” button.

7. “Run”:

A button that user clicks to exit from the dialog box and run the new session immediately.

If the “Update Session Profile” checkbox is checked, the session file data will be updated, and
the new data will be persistent.

8. “New”:

A button disabled normally, but becomes enabled when the user attempts to add a new
Session ID, by entering a new value in the Session ID field (1).

The user clicks this button to add a new session, and TelitView will bring focus to and
highlight the “Description” field (2) to prompt user to enter the brief description for the
session.

9. “Delete”:

A button for session management purposes.

User clicks to delete a particular session from the existing session list. On execution of this
command, the session is deleted and no longer exists in the session list.

10. In Use:

A list of sessions that are detected by TelitView to be at busy state. This is an un-editable
field.

It provides the user visibility about the run status of other sessions. A busy session will not be
available to run by the user at the particular time.

11. “Cancel”:

A button to abort changes, if any, and exit from the dialog box.
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7.7.3. Examples of User Case

e A Single Instance Run at a Default Session (Session 0)

When running TelitView as a “single” instance (only one instance of TelitView is launched
and running), the user does not need to do anything more for the similar situation.

e A Single Instance Run at a User-Created Session

e (Session 3)

The following figure illustrates scenarios that TelitView is running on a custom-created
Session 3, as indicated at the TelitView status bar.

TelitView will use the setup parameters and windows placement data of the previous run of
TelitView when it closes.

#_(Ee
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Setup  View Tools Commands Test Windows Help

=R AR - | 0w % % @
T MMEA Monitor [Module: 5L869/5L869-DR] =] [#38] | T Scatter Plot ==

SPMTK102 + B Send Navigation Update
utc: [ 182800] la | 33670843 ]

- - DoF: | 0.0] Lon: | 117653848
SV Tracked: L
RX
Set Pos as Reference i
$PSTM3DGYRD,2819426716,-36.-13,-18,0,1%4E

$PSTM3DGYRO,2819494888,.-60,-8,40,0,1°57
$PSTM3DGYRO,2819563047.-48.2,16.0,1*7A
$PSTM3DGYRO.2819631251.-56.-13.-6.0.1°75
$PSTM3DGYRO.2819699531.-15.-17.3.0.1°5D
$SPSTMDRGPS,33.670842997.-117.653848265,-0.0064°
SPSTMDRSTYPE,3°58
$PSTMDRSTEP,15,1.64862,0.00197,0,0,1.000,1.000,1* d
SPSTMDRUPD.- 2.6.0.0.0.00.0.000.0.000.0.000000* :It
SPSTMDRSTATE.- 1475745237 33.6708214.-117.65389
SPSTMDRCOV 45.14,45.14,23044 2470,101.8270,28.52
$PSTMDRCAL,0,0,0,1743
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Figure 62 Single instance run of TelitView

o Multiple Instance Runs (Different Sessions)

Based on the session structure in multiple instance runs, creating different sessions is
necessary.

%
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Figure 63 Multiple instance runs of TelitView
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7.8. Convert Data File
7.8.1. File Conversion Dialog Box
> Menu: Setup > Convert
T File Conversion EIE@
R C:\MNewNMEAFile b : [:::]
Converson Type:
Output Fie: C:\NewNMEAFile nmea : E
Cancel i Convert ’

Figure 64 File conversion dialog box

7.8.2. Data Formats in File

e Source File
User browses or specifies the file path and name as the source file that TelitView will read
from and the conversion is conduct upon.

The file format supported is expected to be a text format file that contains standard NMEA
sentences, such as the NMEA file generated with TelitView as the data log file. In addition to
the standard NMEA sentences, the source data file may contain other text messages or
proprietary NMEA sentences, and they will be ignored by the conversion process.

If the log file generated by TelitView with the PC “timestamping” turned ON, the time stamp
information will be ignored and the conversion will not be affected.

e Conversion Type

There can be various data types that conversions will gradually add and support. The
selection is made through the pick on the “Conversion Type” dropdown list.

Currently, the supported conversion is to convert the standard NMEA sentences found in the
source file into a NMEA format that is one of the data formats Google Earth will take as an
input file.

e OQutput File

User browses or specifies the file path and name as the output file as a result of conversion.
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7.8.3. Run Conversion

e Convert File

User clicks “Convert” button to start the conversion.

The conversion progress is illustrated by the progress bar, and on completion of conversion,
the “Done” button will replace the initial “Cancel” button and user clicks it to exit from the

dialog box.

T File Conversion EHE‘@
SR CA\TestExampleRun1 bd : E]
Converson Type:

Output Fie: CA\Test\ExampleRun1.nmea : E]
’ﬁ Convert

Figure 65 Convert file

The number of the NMEA sentences found in the conversion is also displayed in the dialog
box (in this example, the number of sentences = 1218).

e Display Tracks by Loading into Google Earth

User can open the resultant file of NMEA format from Google Earth and have the navigation
track displayed (only a part of display is illustrated).

-
& Google Earth
File Edit View Tools Add Hel

¥ Search

v Places
4 ‘@ My Places
- [VJED Sightseeing Tour
Make sure 3D Buildings
layer is checked
4 [V Temporary Places
> [V] &S GPS device

Figure 66 Display the track with Google Earth
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Auto-Change Baud Rate

This feature is turned on by default — but user has a control to disable it. Refer to
Section 7.10.1 Auto-Change Baud Rate Enable/Disable for details.

When TelitView sends a command string to change the baud rate on the UART of the GNSS
module, if the command is recognized as a built-in commands by TelitView, it will
automatically change the baud rate on the current COM port to match the new baud rate.

The entry source that can be recognized by TelitView is from the following:
* A user-entered string in the “Command string” box in the NMEA Monitor
* A command from the “Basic Commands”
* A command from the “User commands”

This feature is supported in all GNSS products, as listed in the Section 7.1.2 Product .

Special Test Settings

> Menu: Test > Special Test Settings

This dialog box allows user to set up various testing flags or TelitView system conditions that
are special or to change the default behavior of TelitView.

T Special Test Settings | B |3

Auto-change Baudrate Enabled
MT 32 modules

Disable EAS™Y on reset

Figure 67: Special test settings

Currently the special test setting offered in TelitView for setups contains the following

» Auto-change Baud rate Enabled
» Disable EASY on reset

Their use is described in details next.

S “ LH 3
L ] iz
PR
—
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Auto-Change Baud Rate Enable/Disable

As default, when TelitView sends a command string to change the baud rate on the UART of
the GNSS module, if the command can be recognized as a built-in commands by the program,
after the command is sent across, TelitView will automatically change the baud rate on the
current COM port on PC to match the new baud rate.

However, there are some testing situations that this auto-change feature is not desired; so the
feature can be controlled by user by checking/unchecking the corresponding check box.

If the feature is disabled, under the user’s command to change the baud rate on the UART of
the module, TelitView still sends user’s command string cross, but will not attempt to auto-
change the baud rate of the serial port on the PC to match the new baud rate — the user will
see a freeze of data activities on the NMEA Monitor window (if it is open). It becomes user’s
responsibility to disconnect/reconnect the serial port with the new baud rate that matches the
new UART baud rate of the UART, in order to re-establish the serial communication.

Disable EASY on Reset

The EASY is a navigation solution feature developed and supported by Mediatek®.

There are some testing situations that EASY is ON is not desired. To force to turn off the
EASY on reset, check the “Disable EASY on reset” checkbox.

With this being checked on, TelitView will send a command string to the MT33xx module, to
turn off EASY on every start-up message from power-on event or a reset event at the client
module.
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8. EPO Feature

The EPO stands for Extended Prediction Orbit — a type of server-generated extended
ephemeris developed and supported by Mediatek®.

8.1. EPO Source Setup and Get EPO

> Menu: Tools > EPO Host Manager

The following figure illustrates how it looks like after launching the EPO Host Manager.

,

EPO File Source Setup

) EPO File Attributes
() EPO Server  Server Address

http://epo telt.com GP3

User Name Password File Name: GLONASS [T] Generation
slkdfa Skd7owe35 MTK30.EPO File Size (bytes)
@ Local EPO Fle (defaul) E] Vad Len Segmerts
C:\Users'luowa\Downloads\EPO_GPS_6h.DAT Extension Days
Assistance Data EPO Update Status
i
Days #of Epoch EFQ DLL inttiglized...
Guery EPO Status WeekMum TOW
e, |
EIEEY Final Epoch
Crt Min E..
Cmt Max E...
Trans Len E

Update EPO Abort

Host Aiding (auto-send when restart)

[ System time Lat Lon
[T] Ref Position 33670678 -117.653925
[ Host EFO

e =

Figure 68 EPO Host Manager

8.1.1. EPO File Source Setup

User selects one of following two ways to specify how to get the EPO data ready for transfer
to a client module.

1) EPO Server

e  When the “EPO Server” checkbox is checked, it is expected that the user is going to
download an EPO file from a remote server.
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User enter the information needed to locate the correct EPO server and provide credentials
and file name to download an EPO file.

EPO File Source Setup

fttp./ /epo telt.com

User Name Password File Name
100000 100000 EPO_GPS_7.DAT

Local EPO File (defautt) i)
C:\EPO_GPS_7.DAT

Figure 69 EPO Host Manager: EPO file source setup

2) Local EPO File (default)

o  When the “Local EPO File” checkbox is checked, user uses the browse button (as circled
below), if desired, to locate an EPO file that has been stored in the local media.

The “default” indicates that EPO Host Manager Window start always s with the local file as
the EPO file source.

Notice that, in order to minimize confusion, when the checkbox is checked for the local EPO
file, the file name for the EPO server is greyed out, indicating that information is not being
used.

EPO File Source Setup
EPO Server  Server Address

hitp://epo telt.com
User Name Password File Name
K000 K000 EPO_GPS_6h.DAT

@) Local EPO File Mefault)

C:\EPO_GPS_7.DAT

Figure 70 Browse for local EPO file

: | =

Reproduction forbidden without written authorization from Telit Communications S.p.A. - All Rights
Reserved. Page 96 of 120



8.1.2.

Telit

TelitView User Guide
1VV0301168 Rev.5 - 2016-02-22

EPO File Properties and Their Selections

Based on the EPO-II specifications, EPO files offered for download at the EPO server contain
“properties” that differentiate each file from another, such as GNSS constellation selection
and the validity length.

As a convenience provided for customer, these properties are reflected in the name of each
file.

The EPO Host Manager window has an “EPO File Attributes” pane to assist user in EPO file
property selection or display.

These controls are used differently when the EPO source is using “EPO Server” or “Local
EPO File”.

1) When the “EPO Server” is selected as the EPO source, it is expected the user is going to
download an EPO file from the server. Thus the EPO file attributes controls are used as a
“configurator” used by the EPO Host Manager to form a proper file name and display it
in the “File Name” for the EPO Server download.

This pane is illustrated by the following diagram: it exemplifies attributes of GPS only, 7 day
validity length for an EPO file.

This file name will be sent, along with the server address, user name, and the password, to the
EPO server for the download of the EPO file.

T EPOC Host Manager

EPQ File Source Setup

_ EPOQ File Attributes

@ EPO Server  Server Address
http://epo telt.com GRs
User Name Password File Name GLONASS ]
00000 0OO00K EPO_GPS_7.DAT

) Local EPO File (defaut) (] Val Len
CAFPO GRS 7 DAT \ )

Figure 71 EPO file of GPS only and the file name

2) When the “Local EPO File” is selected as the EPO source, it is expected that the user
locates the EPO file from a local storage media. Thus the EPO file attributes controls turn
to be an “indicator” displayed to user as the properties of the file, based on the file name.

If the file name is the same as that in the EPO server (thus in compliance with the name
standard of what the Telit EPO server uses) for the same properties, then the EPO file
attributes will display the same contents.
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-
T EPO Host Manager

EPO File Source Setup /—\
) EPC File Attributes
() EPO Server  Server Address
http://epo telit.com GP3
User Name Password File Name GLONASS [[]
sledifa Skd7owe 35 MTK30.EFO
® Local EFO File (defaut) Val Len
CAEPO_GPS_7.DAT \ )

Figure 72 Local EPO file of GPS only

Examples:

e The following example illustrates that a user selected a satellite type of GPS +
GLONASS with validity length of 6 hours; the EPO file for download is
EPO_GR_6h.DAT.

EPQ File Source Setup
EPO File Atributes
FPO Server  Server Address
http://epo telit.com GFS
lUser Name Password e Tame GLONASS
slkdifa Skd7owe35 EPO_GR_Bh.DAT
@) Local EPO File (defaul) [:] Val Len
CANEPO_GPS_7.DAT ;}

Figure 73 EPO file of GPS + GLONASS and the file name

The following examples illustrates that a local EPO file has been detected as a GPS only with
14 day validity length properties.

EPQ File Source Setup

/ EPQ File Attibutes \

() EPO Server  Server Address

http://epo telit.com GFS
Lser Name Password File Name GLONASS []
slkdifa Skd7owe35 EPO_GPS_14.DAT)|

cal EFO File (defaut) ValLen [14d
C:\EPO_GPS_14.DAT \ /

Figure 74 Local EPO file of GPS only and 14 day validity

ie_fE
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8.1.3. Get EPO

After a user selects an EPO source from the above — either the remote EPO server with the
user-entered credentials, or the local directory, he can click the “Get EPO” button to have
TelitView go to the correct source location to get the EPO file.

Note: if the EPO file is from a server, the download process may take a second or two, and
the file will be automatically saved at the user’s “\Downloads” directory as default. Thus a
user always has an option to use “Local EPO File” as the EPO source by browsing to the
“\Downloads” directory to get the file.

After the target EPO file passed validation check and is loaded into a temporary memory, the
following fields will be populated with the values indicating the file size, segment, and
extension days that are pertaining to the EPO file.

EPO File Attributes
GLONASS [] Generation Il
File Size (bytes) 129024
Val Len Segments 56
BExension Days 14.0

Figure 75 Get EPO file - success!

The above data illustrates the following “envelop” information for a complete EPO file that is
GPS only and 14 days of validity duration:

o File Size: 129024 bytes.
o Segments: 56.
o Extension Days: 14

In the case of getting EPO from a server, if the process failed, a message box can pop up like
this:

p 1
Information Iﬁ

I.-"'_"‘-.I EPO file download from server failed.

WY .. The resource may have been removed, or is temporarily unavailable,
Check server name and credentials, resource name.

|8

Figure 76 EPO file download failed
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8.2. EPO Transfer to Module

8.2.1. Update of EPO (EPO-II Method)

User clicks the “Update EPO” button to initiate the transfer of the EPO data to the client
module, using the EPO-1I method.

Assistance Data
Days
[Queﬁ, EPO Status ] e Selection for EPO validity length:
o User may select a different validity
Final Epoch length for the EPO data to transfer, other
Cmt Min E... than the whole EPO file.
e A valid length can be smaller than, and
e Avalid leng ,
[ up to the whole EPO file.
‘ Update EFO | Abort

Figure 77 EPO download with EPO-Il method
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After user clicks the button to update EPO, the transfer process starts ... until all packets of
EPO data are transferred. The resultant activities are shown in the following diagram.

! EPQ File Source Setup
. EPO File Atributes
() EPO Server  Server Address
hitp://epo telit. com &
User Name Password File Name GLONASS [[] Generation L
slkdifa Skd?owe35 MTK30.EFO File Size (bytes) 129024
© Local EPO File (defaut) (=) Val Len Segments &3
CAEPO_GPS_14.DAT bisliay Ltl
Assistance Data EPO Update Status
Ack: Seq=h87 Result=1 - |
[ Iz 14 #of Epoch ab ] Send the cument packet 588
Query EFO Status Weekhum TOW Ao et packet 569
First Epoch 1853 237600 Ack: Seq=583 Result=1
OrEPO | FnalFpoch | 1855 | 216000 | aopddne S pecket 590
Crmt Min E... 1853 237600 Send the cument packet 551
a Ack: Seq=591 Result=1
Cmit Max E... 1853 255200 Send the cument packet 552
Ack: Seq=592 Result=1
|
Trans Len [14d - Send the cument packet 553
Ack: Seq=593 Result=1
Send the cument packet 554
LsiEEERY Abort Ack: Seq=594 Result=1 T
Send the cument packet 555
Ack: Seq=595 Result=1
Send th: rt packet 536
[l Host Aiding (auto-send when restart) AEE: Se:::glgg Repiiﬂ =
5 i Send the cument packet 557
— fEEis Lat Lon Ack: Seq=597 Resutt=1
[T Ref Position 33670678 -117.653525 Ack: Seq=65535 Result=1
[ Host EPO All "Flash EPQ" data packets have been sent! —
g Comport protocol switched back to PMTK! e |

Figure 78 Success of EPO-Il download

Some highlights of the process:

« A number of packets will be sent to the module for any EPO file. In this case, a total
of 598 packets are sent.

« EPO validity length is 14 days, and there are 56 segment (aka epochs) data in this
transfer.

«  On completion of the transfer, a query of EPO command will be sent by the EPO
Host Manager and the EPO status data pane will be updated with latest status of the
EPO.

Selection of EPO Validity Length for Transfer

EPO Host Manager allows user to custom-select a different validity length of EPO data to
transfer, other than the EPO file entirely. Obviously a valid range of the validity length is the
one that is smaller than, and can be up to the whole validity length of the EPO file.

For any validity length selection smaller than the full file, EPO Host Manager transfers a
partial EPO file from the start, and stops the specified the length.
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Failure in EPO Data Transfer

During the transfer of EPO data to the module using the EPO-1I method, even though it is not
required for the host to wait an Acknowledgement message for each EPO data packet
received by the module, the presence of the Acknowledgement messages for the packets can
be used as an indicator whether the transfer is occurring or not.

The following figure illustrates that no Ack messages are observed, that means a transfer is
not happening.

EPO Update Status

EPOQ DLL intiglized. ..

Open EPO file: C:M\Usersuowa Downloads \EFO_GPS_3.DAT
File size read: 27648

Total Packets to download: 43

GPS hr: 311274 (EPO: Wi=1852, TOW=436300)
Send the cument packet 0

Send the cument packet 1

Send the cument packet 2

Send the cument packet 3

Send the cument packet 4

Send the cument packet 5

Send the cument packet &

Send the cument packet 7

Send the cument packet &

Send the cument packet 9

Send the cumrent packet 10

Figure 79 EPO downloading but it is not happening

The above situation can occur as a result of possible causes such as the client module and the
host are not communicating, the client module is a ROM based device that does not accept
EPO-II (a flash EPO oriented), etc.
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Host EPO (Host-EPO Method)

The EPO Host Manager window has the “Host Aiding” panel for user to set up the Host-EPO
feature.

The Host EPO process is initiated when a system start-up message, $PMTK010,001 is
received by the host, thus in this panel what a user shall do is to enabling the host-aiding
messages, by checking the corresponding checkboxes, that will be sent to the client module.

There are three host aiding messages that are defined by the Host-EPO protocol, which the
user can activate:

1. System time

A user can check the “System Time” box to enable the EPO Host Manager to provide the
system time to the client module. A time in UTC format is required for system aiding.

2. Reference Position

A user can check the “Ref Position” box to enable the EPO Host Manager to provide a
reference position to the client module. The position information used here is the same source
as those in the Section 7.5 Configure Reference Position.

3. Host EPO

A user can check the “Host EPO” box to enable the EPO Host Manager to send the Host EPO
data to the client module.

The Host EPO data is sent in the form of proprietary NMEA text strings; each string contains
a single satellite EPO data.

The following diagram illustrates that all three host aiding messages are activated by the user,
and after the user issue a reset command (i.e. a WARM restart),

P T %
% |Lr: z
- > :
PR
Hilyd
— .
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-
T EPO Host Manager [ CAOCurProjects\TelitViewWL\ TelitVie

EPO File Source Setup
EPO File Attributes

(7) EPO Server  Server Address GelEFO
hitp://epo telit. com GPS -

User Name Password File Name GLONASS [] Generation Il
skdfa SkdZowe35 MTK30.EFO File Size (bytes) 129024
® Local EPO Fie (defauit) () Val Len Segments 3
C\EPO_GPS_14.DAT Bxtension Days 140
Assistance Data EPO Update Status
EPO DLL initialized...
e BT Epa SysTime aiding sert. SPMTK740.2015.7,14.23.43 40°07
PR E— RefPos aiding sert: SPMTK741,33 670672 117.653925,0,2015.7.1
STETERERENE secm Open EPO file: C:AEPO_GPS_ 14 DAT
First Epoch GPS hr: 311375 {Cumt UTC: 23:00 07/14/2015)
Cir EFO GPS hr: 311370 (EPO data: Wk=1853, TOW=237600)
Final Epoch Unhealthy sat: &
Crmt Min E...
Cmt MaxcE...

Ters en

Update EFO Abort

Host Aiding (auto-send when restart)

System time Lat Laon

Ref Pastion 33670678 -117.653925
Host EPQ ]

1 k

Figure 80 Host EPO setup
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The TTFF from this WARM reset is 5.9 second, as shown in the following diagram.

Setup Views Tools Commands Test Windows Help
1R e n om B EDe % E

E=S
T NMEA Monitor [Module: SL871/5L869-V2] o |[@ 52 || T Navigation States =sEc]
]

EEMTRIO Date/Time (UTC) 0773072075 2330.09
e L O e [
sPT0z e Lo [

Latitude [] 3367091 765391

Longitude [] / -
SPMTK10231 SGLGSV.3.3.10.83,08.080.23,86.03.287.20"6C DOPs P/H/V )
SGNRMC,233008.000.A,3340.2547.N,11730.23

ggﬂ&gfggﬂoﬁ; SGNVTG,83.75.T..M.0.00.N.0.00,K A" 1A GPS InView / Used
SPMTKO11 MTKGPS-08 SGNGGA.233008.000.3340.2547.N.11739.234¢
SPMTKO10,002°2D SGPGSAA,3.12,29.2502.21,31,20,05....1.10,0
SGLGSAA3,69,85,75.70,68.......1.10,0.75,0.80"
SGPGSV,3,1,10,25,68,269,30,05,50,004,32,12 £ BDS InView / Used
SGPGSV,3.2,10,20.45318,44,20.42,184, 22 027
SGPGSV.3.3.10.31.00.303.18,06.01.057*7F
SGLGSV.3.1.10.69.44.076.33.84.44.037.33.85.4

RX

n

GLO InView / Used

)

T Signal Quality Chart

Display Threshold 5
I src Sid Ele Azi St CHo 50
W 45
| cp2 8 471
GP5 59 1 B = 0— ||
| GP 6 1 0 & 3
GP 12 55 1741 26 8 35 — — F
GP 20 &2 1841 2 =
GP 21 13 2611 2 £ » —
GP 25 68 2631 38 .
GP 25 45 2131 4 S —
GP 31 9§ 3031 18 3 o |
-] -
TS _

< — 0 »
| [Session ID: 0] State: Connected [COM26, Baud 9600]

Figure 81 TTFF of Warm restart with Host EPO aiding
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EFQ Update Status

EPO DLL initizlized...

SysTime aiding sent: SPMTK740,2015,7,14,23,43 40707

RefPos aiding sent: SPMTK741,33.670678,-117.653525,0,2015,7 1
COpen EPO file: CHNEPO_GPS_14.DAT

GPS hr: 311375 (Cumt UTC: 23:00 07/14/2015)

GPS hr: 311370 (EPO data: Wk=1853, TOW=237600)

Unhealthy sat: 8

4

1L} I

Figure 82 Host EPO aiding update status

System time sent: “PMTK740, 2015,7,14,23,43,40” — 23:43:40 07/14/2015
Reference position sent:

“PMTK741, 33.670678, -117.653925, 0, ...” — lat = 33.670678, lon = -117.653925,
alt = Om, etc.

Host EPO sent: EPO file: C:\EPO_GPS_14.DAT
Unhealthy satellite: SVID = 8
Debug messages: Current time and the EPO time, etc.
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8.2.3. Assistance Data Panel
[ Assistance Data ]
Days #of Epoch
| Gueny ERO-Status | WeekNum TOW
/
CIr EPO
“Query EPO Final Epoch
Status” button Cmt Min E...
Crrt Max E...

‘ Update EPO ‘ | Abart

Figure 83 EPO Host Manager: Assistance data

e Query EPO Status:

A user can query the current EPO status in the receiver by clicking “Query EPO Status”
button. The response data from the receiver will populate the status fields as shown in the

figure below.

Assistance Data
Days 7 #of Epoch 28

[Guer,r EFQ Statusl f Weskhum TOW
First Epoch | 1854 | 410400

CrEFO | |hnalEpoch | 1855 | 388800
"

CAWnE. |0 ]
CmtMaxE. | O 0

>

Figure 84 Response data to Query EPO status
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e Clear EPO:

A user can clear the EPO stored in the receiver by clicking “Clr EPO” button.
Assistance Data
Days 0 #of Epoch 0

[E]uery EPO Status ] ( WeekNom TOW )
First Epoch 0 1
-l:lr EPO
Final h 0 1
/- \lna E.pcu: )
“CIr EPO” button Cmt Min E... 1854 410400
Cmt Max E... 1854 432000

Figure 85 Response data to Clear EPO

8.3. Auto-Change Baudrate

When TelitView sends a command string to change the baud rate on the UART of the GNSS
module, if the command is recognized as a built-in commands by TelitView, it will
automatically change the baud rate on the current COM port to match the new baud rate.

The entry source that can be recognized by TelitView is from the following:
» A user-entered string in the “Command string” box in the NMEA Monitor
* A command from the “Basic Commands”

A command from the “User commands”

This feature is supported in all GNSS products, as listed in Section 7.1.2 Product .
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9. Appendix

9.1. Display Examples of GNSS Signal

The following figure illustrates GNSS signals in the form of combination of constellations that
are found in the Telit GNSS modules.

9.1.1. GNSS Signal Charts: GPS + GLONASS

These figures illustrate the GNSS signals in the form of GPSS + GLONASS:
» Their SVIDs and signal levels in the Signal Quality Chart view.
» The GNSS source, SVIDs, satellite states and other real time parameters.
» The elevation and azimuth information in the Azimuth Elevation view.
*  GLONASS satellites are shown in the circle.

GPS + GLONASS output from SE873

T Signal Quality Chart EI@
Display Threshold -

Src Sld Ele Az Sta CNo 50

GP 2 67 1891 37
GP5 0 1750 0

0 750 0
64 1 33
\ 1 116 0 0

3211 40
56 1 28
258 1 42
380 0

Signal Quality [dBHz]

GL 74 30 3281 37
0 37 1851 35

5 28 23 B B8 7
GL B3 58 3521 37 SVID

B GPs used B cLoused

Figure 86: Signal quality view: GPS + GLONASS from SE873
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T Azimuth Elevation =R E=R

B GPS used B GLO used

Figure 87: Azimuth and elevation: GPS + GLONASS from SE873

GPS + GLONASS output from SL871

T Signal Quality Chart

o T

Sre Sld Ele Azi 8t CNo

GP 2 80 35 1 46

GP 5 28 1521 40 )
GP 6 39 43 1 42 g
GP 12 72 3121 49 =
GP 17 8 78 1 22 £
GP 24 33 2221 20 ]
GP 25 32 3181 29 =)
GP 20 15 280 1 21 E
3001 26 @

791 2

1321 20

294 1 31

3331 29

7 2011 35

37 1 39

3151 47

265 1 21

Figure 88 Signal quality view: GPS + GLONASS from SL871
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T | Azimuth Elevation (=l = =

B GPS used B G0 used

180

Figure 89: Azimuth elevation: GPS + GLONASS from SL871

GPS + GLONASS output from SL869

T Signal Quality Chart

Display Threshold | == 0 A

Src Sld Ele Azi Sta CNo
GP 2 78 32 1 4
GP 5 30 1501 32 oy
GP B 36 42 1 41 =
GP 12 74 3331 43 =
Ge 17 o115 2
GP 24 31 211 2 E
GP 25 34 313 1 31 <
GP 29 16 2821 M K]
=
2
23
23
31
]
3
B ] 7 4 25 13 44

SV ID

B cPs used

Figure 90: Signal quality view: GPS + GLONASS from SL869
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T Azimuth Elevation = e

B GPS used B GLO used

Figure 91: Azimuth elevation from GPS + GLONASS from SL869

GNSS Signal Charts: GPS + BeiDou

These figures illustrate the GNSS signals in the form of GPSS + BeiDou:
» Their SVIDs and signal levels in the Signal Quality Chart view.
» The GNSS source, SVIDs, satellite states and other real time parameters.
» The elevation and azimuth information in the Azimuth Elevation view.

» BeiDou satellites are shown in the circle.

GPS + BeiDou output from SE873

1 Signl Qualty Chon e
Display Threshold | >=0 - 55
St Sk DR A Im O 50 ] \‘
— 25 LA N
= 2 o1 gz o1 1 £ 40 ¥ ¥ OE P E I ¥ F F /| ‘\
EEEE R 5 EE 2ESE 2 BE 3K 3 2N
= = o351 )
T : 2 a0 — - - EuEm E § 1 E
N E: Eiiiamiiin
= om0l B s 20 — - - _ - - - -
i @ c
PER O R = 15 | e 1 1 1=
w1 [ - 1 - - o
5 — - - —_ - - - ]
0 A
2 4 8 9% 11 12 15 17 20 26 27 28 Bi\148 145 150 151 152 153 155 156 157,
SVID
B cPs usea BDS Used

Figure 92: Signal quality view: GPS + BeiDou from SE873
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T Azimuth Elevation o= | ]

B GPs used BDS s

Figure 93: Azimuth elevation view: GPS + BeiDou from SE873

GPS + BeiDou output from SL871

T Signal Quality Chart =N EoR (5|

Signal Quality [dBHz]

[
i

|
I i
LTl

M 16 19 23 27 28 31 32 41 198201 202 203 204 205 206 207 208 208 A0 211 214

.(-i’ﬁleed BDS Used lumsu;ad ‘SBAS Not Used

Figure 94: Signal quality view: GPS + BeiDou from SL871
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T Azimuth Elevation == =

B GPs used

BDS used B Qzss useq

)
H

Ve

Figure 95: Azimuth elevation view: GPS + BeiDou from SL871

GPS + BeiDou output from SL869
T Signal Quality Chart [E=H EER 5
Display Threshold =0 = .
Src 8ld Ele Azi S o
= o 4 4 \\
GP 12 37 46 1 36 4
GP 14 75 3381 1

78 0
2131
1 68 0

132 0
274 1
313 1

Signal Quality [dBHz]

25 25 28 31 32 14N 142 143 145 146 147 143 13
SVID
B &Ps Used BDS Used [ ]

Figure 96: Signal quality: GPS + BeiDou from SL869
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T Azimuth Elevation o ===

B GPS used BDS used B

270 b%%gi;‘; J’." 90
120

240 -—r
@~

Figure 97: Azimuth elevation: GPS + BeiDou from SL869

9.1.3. GNSS Signal Charts: QZSS

The following figure illustrates the use status QZSS:
» SVID =193, and its signal level is shown in the Signal Quality Chart view

T Signal Quality Chart E=R B 5

Signal Quality [dBHz]

T\

16 19 23 27 28 31 32 N\ 193 2g9202 203 204 205 206 207 208 208 210 211 214
sV

.(-i’ﬁleed BDS Used lumsu;ad ‘SBAS Not Used

T 11

Figure 98 Signal quality view: QZSS from SL871
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T Azimuth Elevation == =

B GPs used BDS used B Qzss useq

Figure 99 Azimuth elevation view: QZSS from SL871

9.1.4. GNSS Signal Charts: GPS + GALILEO

These figures illustrate the GNSS signals in the form of GPSS + Galileo:
» Their SVIDs and signal levels in the Signal Quality Chart view.
» The GNSS source, SVIDs, satellite states and other real time parameters.
» The elevation and azimuth information in the Azimuth Elevation view.
» Galileo satellites are shown in the circle.

T Signal Quality Chart

Display Threshold  |[>=30 =

Sc Sd Be Ax S

5]
Z
kS

Signal Quality [dBHz]

ARRERRORRYYRES
Eg
HURBHBYURPHRERARE

7]
g
ERSgBURERuEEI -

ENE
&
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T Azimuth Elevation o] 3|3
Bcpsu C GAL u B azss o
V

Indicate Galileo
satellites are being
used in position fix.

Figure 101 Azimuth elevation view: GPS + Galileo from SL871

9.1.5. GNSS Signal Charts: GPS + GLONASS + GALILEO
T Signal Quality Chart
Avg.Cho|39.9| Display Threehold
Sz S Ek Azi S@m CHa
GP16 47 315 1 45
LT T - < - I | 43 —_—
G W B & 1 4 o
L=l N I < T | 43 =]
GP T 1 ™ 1 | -}
LT I = B - -
GP ® oA 20 40 .E‘
GP B M me 41 =
GP ™ el <l 1 42 =1
GP o3l 2| 20 1 42 =2
RO - T | I B | k) E
Gl 23 om o1 @ 2
GLoEoo1m 13 o M w
GLomoos @Imoa n
e TR A~ << | I | A
GLoWmoo®» W 40
GLomo® 43 42
GLo3m 5 313 1 43
Gl e X al
0l 23 340 1 42
L=~ - B | 40
LR - RN A - T | 1
Bersu Poouw BPeau SBAS n/u

Figure 102 Signal quality view: GPS + GLONASS + Galileo from SL871

9.2. FAQ and Error Info

9.2.1. Error: “The serial is not ready”

When this error box pops up, it indicates the program attempted but failed to open the serial
port with the name as specified. A normal cause is that the port is unavailable.

el =z
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Error Iﬁ

Figure 103 Prompt for COM port setup failure

There can be different reasons for a serial port to become unavailable.

For example, a port used in a connection profile, also known as a session, may become
unavailable if it is used by another instance of TelitView. Another example, is when the USB
cable is disconnected and the operating system removes it from the list of ports.

A session is running by another TelitView

This dialog box indicates when a TelitView starts at a particular session, the same session has
been running (by another instance of TelitView).

Note: TelitView does not prevent user from running an instance on the same session. It only
warns user if multiple instances of TelitView are running the same session, then they share
the same connection profile parameter and may change the parameters that are not expected.

=
Information ﬁ

|"/.._.'“-. This instance starts on session 1D = 0
"W This session ID is running by another TelitView,

Please choose or add another session.

'

Figure 104 Prompt for concurrent running session

Information: “Do you want to update them in the Session
setup”
When this dialog box pops up, it is because some parameters of the serial port have been

changed, and the parameters are part of the connection profile. As a result, the user is
prompted to be aware the change will affect the session.
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- i -
Session configuration ﬁ

I.-" & 'You are running Session = 4.

&' You have changed the Com port/ Baud rate from the initial values for
the Session..

Do you want to update them the Session setup?

| ok || cance ||

Figure 105 Prompt for updating/overwriting a session setup
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